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WARNINGS 
 
EMERGENCY STOP—Should an emergency arise and the animal scanning bed 
needs to be stopped instantly or the unit completely powered down, PUSH THE 
MASTER SYSTEM ON/OFF BUTTON AT THE REAR OF THE SCANNER 
ENCLOSURE TO “OFF”. THIS ACTION WILL IMMEDIATELY STOP THE  BED 
MOTOR, TURN OFF THE HIGH VOLTAGE TO THE DETECTOR ARRAY AND 
ELECTRONICS AND DISABLE ANY FURTHER ACTIONS UNTIL THE SYSTEM IS 
RESET.  
 
BED MOVEMENTS—FINGERS, etc.  When moving the animal scanning bed take 
care to insure that fingers, coat tails, sleeves and other objects are not near, or in, the 
mechanisms that moves the animal scanning bed horizontally. Fingers or objects 
caught between the moving parts and the end-stops of the bed or vertical bed support 
could be injured. or damaged.  Never try to stop bed movement by hand, always use 
the hand controller. 
 
BED MOVEMENTS—DAMAGE TO GANTRY.  As the animal bed is being inserted 
into the gantry aperture MAKE CERTAIN by eye that the BED, THE SUBJECT AND 
ANY ATTACHED DEVICES will actually pass into the aperture without hitting the 
edge of the aperture or the transmission annulus if in place. Injury to the animal or 
damage to the gantry could result if the animal or ancillary equipment are allowed to 
collide with the gantry.  
 
FLUIDS SPILLED ONTO THE GANTRY TABLE—Should any fluids, e.g. water, 
urine, etc., be spilled onto the surface of the gantry tabletop, IMMEDIATELY WIPE 
THE FLUID UP WITH A SPONGE OR OTHER ABSORBENT MATERIAL.  If fluids 
have dripped through the slot under the bed, carefully and SLOWLY remove the tray 
underneath the slot (and below the tabletop), taking care not to spill any fluid into the 
electronics below. Decontaminate and dry before replacing under the table top. 
 
RADIOACTIVE SPILLS OR CONTAMINATION OF THE BED OR INSIDE OF 
GANTRY APERTURE—If a radioactive fluid, e.g. radioactive urine or blood, is spilled 
onto the animal imaging bed or onto the cylindrical surface inside the imaging 
aperture, this radioactivity must be removed at the first convenient opportunity and 
before the next imaging study.  Contamination of the imaging bed can be removed 
most easily by dismounting the imaging bed and washing the bed with a suitable 
cleaner while drying with an absorbent towel.  The aperture is protected by a plastic 
cylindrical insert that can be removed and cleaned in a similar way.  Note that this 
sleeve must be replaced before the next imaging study since it protects the detector 
array from physical damage and from fluids leaks. Before the bed or sleeve is placed 
back in the scanner’s field-of-view, these parts should be cleaned until no 
contamination of either bed or sleeve can be detected with a G-M counter. 
 
HIGH  VOLTAGE— Do not remove the gantry or enclosure covers for any reason.  
Circuit boards on the detector array (inside the gantry cover and normally invisible to 
the User) carry high voltage and serious injury can result if touched.  Do not remove 
the covers on any of the electronics boxes within the gantry enclosure.  Devices 
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within these boxes utilize high current and serious injury can result if touched.  Only 
qualified VISTA-CT service personnel should access parts within the gantry cover or 
within the gantry enclosure.  Removal of any external cover by unauthorized 
personnel voids the warranty. 
 
MOVING  VISTA-CT TO  ANOTHER  LOCATION—VISTA-CT consists of a number 
of electronic components that are sensitive to physical shock.  If VISTA-CT is to be 
moved to another location, unlock the wheels and roll the gantry enclosure SLOWLY 
and deliberately  to avoid any jarring shocks such as can occur when crossing 
building expansion joints often found in corridors, or across the gap between building 
floor and elevator floor if VISTA-CT is moved into an elevator. Rough treatment can 
seriously damage internal components and common sense and patience when 
moving VISTA-CT should be exercised.  You should consult the sections on “Siting” 
and “Pre-Installation” in the Appendix to determine if the site to which the scanner is 
being moved meets the required evnironmental conditions needed for proper 
operation of the scanner. 
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PRECAUTIONS DURING OPERATION 
 

IDENTIFY THE SYSTEM ON/OFF SWITCH AND OTHER HARDWARE ELEMENTS 
OF VISTA-CT BEFORE USING THE SYSTEM. 
 
DO NOT TURN  VISTA-CT OFF UNLESS  ABSOLUTELY  ESSENTIAL—Under 
normal conditions, VISTA-CT should be left fully powered at all times.  If you have 
found VISTA-CT fully powered, use the “hot start” procedures described in a later 
section to begin imaging.  If you have found VISTA-CT powered down, follow the 
“cold start” procedures described in a later section before you begin imaging.  After a 
cold start, VISTA-CT should be allowed to warm up for 48 hours before imaging is 
attempted and several diagnostic tests should be run to make sure that VISTA-CT is 
still properly calibrated.  
 
STARTING VISTA-CT AFTER A POWER FAILURE—If electrical power to      
VISTA-CT is interrupted and the system shuts down, push the main ON/OFF switch 
at the back of the enclosure to the OFF position.  When power is restored, push the 
switch back to the ON position.  This action will engage an automatic restart 
procedure. During this procedure, which takes about 2 minutes to run to completion, 
NO COMMANDS SHOULD BE ISSUED TO THE SCANNER THROUGH THE 
WORKSTATION. (See APPENDIX D—“starting/stopping the data acquisition 
computer” for further details). 
 
AVOID PLACING HIGH  ACTIVITY  RADIOACTIVE SOURCES  NEAR  THE  
VISTA GANTRY  DURING IMAGING—VISTA is reasonably well-shielded against 
radiation emanating from sources  directly in front, or directly behind, the VISTA 
gantry but VISTA is completely UNSHIELDED from sources located at the sides 
or on the top of the gantry.  Accordingly , the enclosure tabletop and the top of the 
gantry  cover should never be used to store radioactive material nor should 
radioactive sources of any strength EVER be placed at the sides or on top of the 
gantry  cover during imaging.  To do so will severely comprised the performance of 
VISTA and render the acquired data useless.  CHECK FOR AND  REMOVE all 
radioactive source from the vicinity of VISTA, e.g. empty injection syringes,  empty 
injection bottles, swabs made radioactive during injection, etc. before beginning any 
imaging study. 
 
CENTER  THE  IMAGING TARGET BOTH VERTICALLY AND AXIALLY IN THE 
IMAGING APERTURE BEFORE SCANNING—The sensitivity of VISTA and any 
other ring-type PET scanner depends strongly on the axial position of the target  in 
the scanning field and to a lessor extent on the radial position.  It is important, 
therefore, that the center of the imaging target, e.g. the brain, be placed as close as 
possible to the axial center of the scanning field using the CENTER command on the 
acquisition interface.  In addition you should use the vertical screw mechanism to 
manually and visually position the animal’s (horizontal) body axis along the cenral 
axis of the scanning field taking care that the animal and any attached equipment will 
pass into the imaging region without hitting the sides of the aperture (or the 
transmission annulus if in place).  
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INTRODUCTION TO VISTA-CT 
 

              
 
Theory of Operation 
 
VISTA scanners are manufactured in two forms, a single detector ring version (the 
SR for “Single Ring tomograph”) and a two ring version (or DR for “Dual Ring 
tomograph”).  Both systems have the same transverse aperture size and field-of-
view, both utilize the same high sensitivity, dual-layer phoswich PET detector 
technology and both possess identical functional and analytical capabilities. 
 
The SR and DR systems differ only in the lengths of their respective axial fields-of-
view: 2 cm for the SR and 4.8 cm for the DR.  In this manual we will use the 
convention of specifying SR parameters in parentheses if different from the DR. A 
parameter quoted in the text without any distinction as to type indicates that the 
parameter is the same for both scanners. 
 
The VISTA detector array consists of 36 (18, SR) detector modules arranged around 
a circle such that the face-to-face diameter of the ring is 11.8 cm.  Each detector 
module is placed in time coincidence with the 14 (7) opposite modules to give an 
effective transverse field-of-view of 6.7 cm and an axial field-of-view of 4.8-cm (2-cm).  
Each detector module  consists of an 13 x 13 array of 1.45 mm square by 15 mm 
long “phoswich” elements optically isolated from each other by reflective material.  
Each phoswich element, in turn, is comprised of two different scintillator crystals, a  
1.45 mm square x 7 mm long LYSO crystal and 1.45 mm square x 8 mm long GSO 
crystal, optically glued together end-to-end to form a single 15 mm long segment.  
The GSO end of the 13 x 13 array is optically glued to the face of a Hamamatsu 
R8520-C12 position-sensitive photomultiplier tube (PSPMT).  
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In operation, light from a scintillation event in the (front) LYSO layer passes through 
the GSO layer onto the photocathode of the PSPMT and is detected.  Similarly, 
scintillation light from an event in a GSO (back) crystal passes back and forth from 
the LYSO and GSO layers and ultimately falls on the PSPMT where it is detected.  
This process is enhanced by inserting each phoswich element into a 13 x 13 matrix of 
highly reflective material which improves direction of scintillation light onto the 
PSPMT while optically isolating each phoswich element from its neighbors. 
 
This use of dual-layer phoswich detector modules is a central and important feature 
of the VISTA design.  Conventional small ring diameter scanners suffer from the 
“depth-of-interaction” (DOI) effect, a parallax phenomenon that causes (radial) spatial 
resolution to degrade with increasing radial distance from the center of the field-of-
view (FOV) of the scanner.  While this effect can be reduced by increasing ring 
diameter or decreasing crystal thickness, this strategy will also reduce sensitivity by 
moving the detectors further from the animal or reducing absorption of annihilation 
radiation.  The VISTA design side-steps this problem by allowing a two-level estimate 
of the depth at which an annihilation photon in absorbed in the phoswich crystal 
element, either in the LYSO portion of the element or in the GSO portion.  Knowledge 
of this depth, even to this relatively crude level of accuracy, substantially reduces the 
DOI effect for VISTA while preserving sensitivity compared to other scanners of 
similar ring diameter but without this capability.   
 
The method used to determine whether the scintillation event occurs in the LYSO or 
GSO portions of the phoswich exploits the difference between scintillators in their 
light decay time. Since LYSO and GSO possess different light decay times (40 ns for 
LYSO and 60 ns for GSO) the event may be assigned to the proper layer, or depth, 
by knowing the light decay time for that event.   
 
The dual-layer phoswich arrays allow three types of coincidence interactions to be 
recorded, LYSO to LYSO, LYSO to GSO and GSO to GSO, for a total of 
approximately 28.8 million (7.2 million)) valid coincidence lines passing through the 
6.7 cm diameter x 4.8-cm (2-cm) deep FOV.  These data are sorted into 61 (25) 2D 
sinograms with the 3D FORE algorithm and reconstructed with either 2D filtered 
backprojection or 2D OSEM into 61 (25) transverse section images that span the 
axial FOV. 
 
 



 10 

Specifications, Performance Characteristics and Capabilities  
 
Specifications 
 
Detector modules 
Type of modules = dual layer phoswich- front layer= LYSO, back layer = GSO 
Crystal dimensions = 1.45 mm x 1.45 mm x 7 mm LYSO, 1.45 mm x 1.45 mm x 
     8 mm GSO 
Light decay time = 40 ns, LYSO and 60 ns GSO 
Crystal arrays = square 13 x 13 – 20 mm x 20 mm outside dimensions 
Pitch = 1.55 mm 
Phototubes = Hamamatsu R8520-C12 
 
System 
Number of detector modules = 36 (18) 
Number of phoswich elements = 6084 (3042) 
Total number of crystals = 12,168 (6084) 
Ring diameter = 11.8 cm 
Gantry aperture = 8 cm 
Axial field-of-view = 4.8 cm (2.0 cm) 
Effective transaxial field-of-view = 6.7 cm 
Normalization/transmission source: Ge-68 filled annulus – 500-600 microCuries 
  nominal starting activity; half-life = 275 days 
Overall dimensions = 121 cm wide x 151 cm high x 82 cm deep 
  = 47.75” wide x 59.5 “ high x 32. 0” deep 
Estimated weight = 450 pounds 
Power = 120 V AC, < 20 amps 
 
Data Sets 
Acquisition mode = 3D (only) 
Total number of lines-of-response = 28.8 M (7.2 M) 
Number of 2D sinograms = 61 (25)  
2D sinogram size = 175 spatial samples x 128 angles 
2D dataset size = 5.4 Mbytes (2.2 Mbytes) 
Sampling distance = 0.775 mm 
 
Bed/Laser 
Two low absorption carbon fiber beds provided: rat or mouse 
Computer controlled axial centering of imaging target following laser  
   identification of target outside gantry 
Hand controller for manual bed movement/laser on/off 
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Performance Characteristics*  
 
Absolute central point source sensitivity (250-700 keV window):  
   4.0% DR 
   1.9% SR 
Reconstructed central (radial) spatial resolution: 1.5 mm (FBP/ramp filter) 
Off-axis  spatial resolution = <1.8 mm @ 1.0 cm, <2.2 mm @ 2.0 cm (FBP/ramp) 
Average energy resolution = 30% LYSO layer, 30% GSO layer, 30% system 
Scatter fraction-mouse-sized object, energy window 250-700 keV:  27% (20%) 
Scatter fraction-rat-sized object, energy window 250-700 keV: 37% (28%) 
Coincidence timing windows:  
                     +2.5 ns (LYSO/LYSO) 
                     +3.5 ns (LYSO/GSO) 
                     +5.0 ns (GSO/GSO) 
Coincidence timing resolution approximately half of these values 
Peak NEC rates (250-700 keV energy window): 
  Mouse phantom (3 cm diameter cylinder 7.5 cm long) =126 kcps@ 12.2 µCi/cc 
  Rat phantom (5 cm diameter cylinder 15 cm long) =  77 kcps@ 3.7 µCi/cc 
*all values + 10% 
 
Features/Capabilities 
Real-time 2D persistence projection imaging of field-of-view during scanning 
Laser positioning of animal with automatic insertion into central FOV 
 
Data acquisition modes: 
Static imaging: acquire single data set from a time-stationary tracer distribution 
Fixed frame length dynamic imaging: acquire data sets from dynamically 
   varying tracer distributions using fixed frame durations 
Variable frame duration dynamic imaging: acquire data sets from dynamically 
   varying tracer distributions using variable frame durations  
List mode: acquire data in List mode; allows post–acquisition frame formatting 
Whole-body imaging: acquire static image data from several consecutive bed 
   positions and automatically merge into a single whole-body image 
Transmission imaging: acquire a transmission data set of an object using the 
   Ge-68 source transmission source 
Blank imaging: acquire a data set using the Ge-68 transmission source used both 
  for detector normalization and as the “blank scan” for attenuation correction 
 
Image Reconstruction: 
Convert all 3D data sets to 2D sinograms with the FORE algorithm 
Reconstruct 2D sinograms with 2D FBP or 2D OSEM 
Correct reconstructions of all data types for randoms, scatter and attenuation 
 
Visualization and Analysis:  
View all data types and apply various analysis tools 
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Injected Activity Recommendations for VISTA 
 
Like any small animal PET scanner, VISTA has a useful linear operating range for 
radioactivity placed in the imaging volume.  The activity values quoted below are 
approximate and you should perform your own experiments to make sure you are 
operating within this range, particularly if you plan to use the scanner in unusual ways 
or with “non-traditional” isotopes.   
 
You can make such measurements by using the START/STOP data acquisition 
interface (see page 34) to monitor the system dead time when experimental 
quantities of activity are placed in the field of view.  The “dead time” value reported on 
this menu can tell you whether this amount of activity is excessive and hence likely to 
be outside the linear range. Generally speaking, dead time should not exceed 30% at 
any time during a study and the activity should be reduced until this condition is met. 
 
For the VISTA DR and SR machines, this linear operating range is (approximately) 1 
- 400 microCuries of F-18 equivalent activity within the axial field-of-view.  If 
quantitative accuracy is critical throughout an experiment, this range cannot be 
exceeded at any time during the study period. Given this value, VISTA studies can 
be carried out successfully with good statistical accuracy in 30 gram mice 
using about 400 microCuries of F-18 labeled compounds and about 1-1.3 mCi 
of F-18 labeled compounds in 350 gram rats.  Maximum injected amounts in any 
given study depend on many factors such as the fraction of the animal’s length that is 
actually in the axial FOV, the temporal and spatial behavior of the compound under 
study and so on.  Nonetheless, these amounts represent typical maximum activities 
for F-18 labeled compounds, e.g. FDG, that distribute themselves throughout the 
body with moderate increases in organ concentration above a uniform body average.  
You should not attempt to perform studies with amounts of activity significantly above 
these values unless you have determined that the amount of activity actually in the 
field of view of the scanner will not exceed 400 microCuries of F-18 equivalent 
activity.  This maximum activity corresponds to the peak NEC rates for the VISTA DR 
and SR scanner and also corresponds to the point at which system dead time 
becomes dominant and further increases in activity actually reduce count rate 
throughput. 
 
These recommendations are based on F-18 equivalent amounts of activity (a pure 
positron emitter) and must be modified if using other, or “non-traditional”, isotopes 
that are not pure positron emitters and/or that emit gamma radiation in coincidence 
with positrons.  For example, Cu-64 is a positron emitter but in only 20% of 
disintegrations does Cu-64 emit a positron.  In this case, if no other conditions were 
operative, you could (should) administer up to 5 times more Cu-64 activity (100% F-
18/20% Cu-64 = 5) than F-18 to obtain the same flux of annihilation gamma rays onto 
the VISTA detector array.  Isotopes like I-124 not only emit positrons in only a fraction 
of disintegrations, but also emits a host of coincident gamma rays that accompany 
every disintegration.  In this case, an extra flux of (useless) coincidence events are 
present that are not present with isotopes that emit only positrons and the amount of 
activity injected must be scaled downward somewhat to compensate for this effect 
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which contributes to the system dead time. On the other hand, like Cu-64, the amount 
of I-124 must be increased because of fractional positron emission compared to F-18.   
 
These and similar effects should be considered when embarking on a new study 
when trying to establish the proper amount of tracer to inject.  In all of these cases, 
“scatter correction” should be selected in the reconstruction menu since the algorithm 
that corrects for scatter is also effective in removing the approximately uniform 
background caused by these coincident gamma events, the Lu-176 background, etc. 
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GETTING STARTED 
 

MAJOR SYSTEM COMPONENTS 
 
VISTA-CT consists of five major subassemblies: a gantry, an enclosure upon which 
the gantry sits, an animal scanning bed that moves along a slot in the scanner 
tabletop, a hand controller for bed movement and a separate operator workstation.  
The animal bed assembly, the vertical bed movement mechanism and the gantry 
aperture are shown in Figure 1. 
 
Gantry –The detector array and associated electronics are located inside the gantry 
enclosure.  At the center of the gantry is the imaging aperture into which the object to 
be imaged is inserted.  Mounted on the front of the gantry and above the aperture is a 
housing containing a laser that, when activated with the hand controller, projects a 
cross-hair onto any object placed on the imaging bed.  
 
Enclosure—The gantry sits on a table that forms the top of an enclosure resting on 
lockable wheels.  All cables (power, cables to operator console, etc.) emerge from the 
rear of the scanner at the center-bottom of this enclosure.  The enclosure contains 
the power supplies for all sub-systems, the data acquisition system and the bed 
motor and motor driver controls. 
 

          
 
     Figure 1. Animal bed, vertical bed movement mechanism and gantry aperture. 
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 Animal scanning bed—A drive is mounted under the tabletop that moves the 
animal imaging bed into and out of the gantry aperture.  Two removable beds of 
different widths are provided, one for mice and a larger one for rats. 
 
Vertical movement of the bed is controlled manually by a hand-operated screw drive 
(Figure 1).  

                                
 
                                            Figure 2.  Hand controller.   
 
Hand Controller-- Horizontal movement of the bed is controlled manually with the 
small hand-held controller unit connected to, and normally “parked” on, one side of 
the gantry (Figure 2). The bed will move continuously in the indicated direction as 
long as the corresponding button is held down.  If  the button is momentarily 
depressed and released, the bed will move in or out in a small step,  
 
A button on this same controller also turns the alignment laser on or off. When the 
laser is turned on a timer is started that will turn the laser off after about one minute of 
operation.   Hitting the laser “on” button will turn the laser back on and restart the 
timer. Pushing the button while the laser is “on” will turn it off. The hand controller can 
be located on either side of the enclosure simply by unplugging the controller from 
one side of the gantry and plugging it in on the opposite side. 
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Operator Console—A separate movable stand with keyboard, system monitor and 
processing computer comprise the User console or Workstation.  The heigth of the 
tabletop on which the monitor and keyboard sit can be adjusted up or down to allow 
standing or seated operation of VISTA-CT.  The operator console can be positioned 
on either side of VISTA-CT for convenience. 
 

                      
 
       Figure 3. Rear of VISTA-CT scanner.  Main ON/OFF switch is the large RED  
                       switch on the left.  
 
SWITCHES/CONNECTORS 
Master ON/OFF switch—All power to the VISTA gantry passes through the master 
ON/OFF switch located at the rear of the enclosure (large red switch at the left in 
Figure 3).  This switch should normally always be in the ON position.  If it is 
necessary to shut the system down immediately in an emergency, move this switch to 
the OFF position. All power to the gantry/enclosure will be interrupted.  The 
workstation is not powered from the gantry and will remain powered even when the 
scanner itself is shut off. 
 
Additional switches and connectors are also shown in Figure 3 that are for SERVICE 
USE ONLY.  When configured properly for a particular User site, the USER 
INTERFACE connector and the INTRANET connector allow remote access to both 
the User workstation and the data acquisition computer inside the VISTA-CT 
enclosure. If these connections are active, most service problems can be efficiently 
diagnosed remotely and new software quickly installed without a physical visit by 
service personnel. 
 
The buttons and connectors on the right side of Figure 3 allow service personnel on-
site access to the data acquisition computer with connectors for keyboard, mouse 
and display.   ON/OFF and RESET switches control the data acquisition computer 
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while the LEDs on the right show the status of this computer (left to right): power, 
hard disk (HD read/write), NIC1, NIC2.  
 
Cold Start Procedure 
If you find that VISTA-CT is completely “off”, first go around to the rear of the gantry 
enclosure and make sure that the main power plug is inserted into an appropriate and 
active 120 VAC, 20 amp outlet.  Also check at the rear to make sure that the two 
internet connections have been made (if available) and that the cable from the 
enclosure to the operator console is connected. Inspect the cables that interlink the 
console, keyboard and monitor to insure they are properly connected.  Since the User 
workstation is not powered from  the VISTA scanner itself, check to make sure that 
the workstation is also connected to a power outlet.  Power up the workstation 
computer as you would any other PC.  If power-up is successful, the VISTA-CT logo 
and the Login menu should appear on the workstation display. 
 
To turn the VISTA scanner on, move the switch at the left-rear of the enclosure to the 
ON position.  Note that the system WILL NOT immediately restart.  Instead, an 
internal timer will begin turning sub-system on in a pre-programmed sequence that 
will insure proper operation and communication between all internal components.  
This pre-programmed start-up procedure takes approximately 120 seconds to 
complete and you must not enter any commands or take any other actions, e.g. 
recycling the on/off switch again, attempting to move the imaging bed, etc., until 
startup is complete. 
 
After such a “cold start” the system should be allowed 48 hours to warm-up before 
starting routine imaging since previously stored calibration tables could be rendered 
invalid by a shutdown.  However, immediately after a cold start a short imaging test 
should be run in order to determine if the scanner restarted properly.  In order to 
verify a successful restart, you should image a “warm” cylinder phantom and verify 
that transverse images of this source are free of any gross streaking artifacts that 
might indicated dropout of one or more detector modules from the VISTA detector 
aray. If this test suggests detector dropout, you should initiate the data acquisition 
system reset procedure described above. If this test indicates that the data 
acquisition system restarted properly, you should perform, at a minimum, the “hot  
start” test procedures described below before imaging animals.   
 
Animal studies should not be performed after a COLD START until at least 
these verification procedures have been carried out and all functional 
capabilities of VISTA-CT demonstrated  by actual operation of the system.    
 
   
Hot Start Procedure 
Under normal operating conditions, VISTA-CT will be left ON and the internal 
electronics will be stable. In this state VISTA-CT is available for immediate use.  If the 
system has been used successfully in the last few days, VISTA-CT will likely be 
operating properly.  If not,  it is prudent to perform at least a minimal set of tests to 
insure that the system is truly operational before undertaking animal imaging studies.  
VISTA-CT is a complex instrument that can potentially fail to operate properly in ways 
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that are not immediately obvious to the User.  Accordingly, a few simple tests have 
been devised to “capture” most, but not all, of these failures and make them known to 
the User.  
 
LYSO count rate test—The lutetium in the LYSO crystals contains a small amount of 
radioactive Lu-176  that emits beta particles and gamma rays.  This small amount of 
contaminant gives rise to an intrinsic “singles” rate in each detector module and to an 
intrinsic true coincidence rate between detector modules (due to beta particle 
interactions in one detector module and detection of the coincident gamma ray in 
another opposing module).  This effect can be used to monitor the stability of VISTA 
over time since the rate at which these events occur is constant (the half-life of Lu-
176, the contaminant, is 30 billion years).  Thus simply activating a static collection 
with no sources present and observing the data acquisition “status” panel on the 
monitor will give an apparent coincidence (and singles) rate that, if the system is 
stable, should be essentially the same from day to day. When VISTA is properly 
calibrated this intrinsic coincidence rate is around 550 cps (230 cps) but the exact 
values are machine-dependent.  Significant departures from this counting rate 
probably indicate electronics drift in one or more system components.  If so, VISTA 
should be re-tuned so that this typical inherent true coincidence rate is restored. 
 
Line source imaging test—A “cool” 1.2 mm ID line source of F-18 (about 100 
microCuries total) should be taped to the imaging bed and placed in the imaging 
aperture such that the line spans the length of the bore and is coincident with the 
scanner axis.  A static data collection should be initiated for at least 10 minutes, 
reconstructed with FBP and displayed.  Each slice should be carefully examined for 
artifacts such as streaks, circles, arcs, etc.  If none are present, the system is 
probably usable.  If obvious artifacts are present, the system is probably out of 
calibration and must be retuned.  Because only a limited part of the field-of-view is 
examined with this test, this test can miss defective detector modules or drifts in the 
placement of certain regions-of-interest used to calibrate the system.  A better system 
test is the “Cylinder” test below. 
 
Cylinder imaging test—A better alternative to the line source test is to image a 
cylinder (about 3 cm diameter x 6 cm length) for 60 minutes that contains about 400 
microCuries of F-18 total.  After FBP reconstruction, the image stack should be free 
of streak, ring or arc artifacts and the activity in the interior of the cylinder should 
appear to vary smoothly across the cylinder diameter.  If artifacts or widely varying 
changes in image brightness within or along the cylinder are present, the system 
must be re-tuned.  If no such artifacts are detected, the system is probably usable. 
This test should probably be performed daily regardless of previous system use just 
to be sure that ensuing animal studies will yield valid measurements.  This particular 
measurement is also required to obtain the relationship between cps per cc seen by 
VISTA and the actual nanoCuries per cc measured by taking an aliquot from the 
cylinder and counting it in a well counter. 
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Logging on to VISTA-CT 
 
--User Name and Password 
 
When VISTA-CT is in an “idle” state awaiting a User, the VISTA-CT User Interface 
should appear as in Figure 4.  If you already have an existing User name and 
Password these data should be entered in the Log-In window shown in                     
Figure 5.  Pressing Login will then allow access all VISTA-CT functions  
 

 
 
                                      Figure 4. VISTA-CT log-in interface. 

 
If a new User is going to work with VISTA-CT for the first time it will be necessary to 
create a new account by clicking on the Add new User button shown in Figure 5. 
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                                             Figure 5. Login window. 
 
The new User should enter (and remember) a User name and a Password in the Add 
User panel shown in Figure 6. The User name can only contain letters, numbers and 
“_”, and must begin with a letter. The length is limited to 16 characters.  Passwords 
should also be chosen free of special characters.  A password that is unacceptable to 
the system will generate an error message until an acceptable form is entered. 
 

                              
 
                                       Figure 6. Add new User window. 
 
 
--VISTA-CT file-naming conventions 
In order to use VISTA-CT to acquire, reconstruct, display and analyze  image data, 
the files generated during these processes must be consistently identified to the User 
interface (and the User).  Accordingly, certain naming conventions that allow    
VISTA-CT, rather than you, to do most of the file bookkeeping chores have been 
created to keep track of raw, reconstructed and analyzed data files.  The easiest way 
to see how this is done is to look, for example, at the data PET acquisition menu 
(Figure 7) for acquiring a STATIC emission image (although we are skipping ahead 
somewhat). 
 
VISTA-CT files are comprised of an unchangeable “base name” to which is appended 
a string of characters that describe the study.  The base name has the form 
“USERS\xxxxxx\IMAGES\………..” where “xxxxxx “ is always the User’s logon name 
and “……..” represents additional characters that depend on study type.  This form of 
file name will appear automatically with every file. 
 
When a new Study Directory is to be created, the User selects “New” in the Study 
Parameters box and types in the new Study Directory name for that acquisition 
series.  If that name were RATE, for example, the characters that follow the last 
backslash might be for PET acquired data, “RATE_13Feb07_Acq018.acq”.  Here the 
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Study Directory name is RATE, the date of the study is 13 February, 2007, this 
particular STATIC (designated by Acq) data acquisition is the 18th acquisition in this 
directory and the extension “.acq” indicates that the file is the acquisition parameter 
file. This text file contains vital information about the scan that is required by the 
image reconstruction, such as the number of “raw” data files of the scan (extension 
“.tru”). 
 

 
 

                               
Figure 7.  Static data PET acquisition panel. 
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The complete name of this particular study for User “Robert” is :  
 
  Users\Robert\IMAGES\RATE\RATE_13Feb07_Acq018.acq 
 
Other PET study types, e.g. dynamic studies, whole-body studies, etc., will have 
DYN_Acq or WB_Acq designators in the Acq position but the acquisition parameter 
files regardless of scan type all end with “.acq”. The number of raw data (“.tru”) files 
depends on the details of the scan, such as number of bed positions or time frames. 
 
The next step is to reconstruct these raw data files into images. To do so, simply 
enter the proper acquisition file name into the appropriate reconstruction window and 
initiate reconstruction.  After reconstruction, the  reconstructed image file has the 
same name but with the extension “.acq” replaced by  the new designation “.hdr & 
.img”   (“.hdr” and “.img” refer to “header” and to “image”, respectively). You need only 
know that these designations represent reconstructed and viewable image files. 
 
If you wish to view the reconstructed images, you need only paste the appropriate 
“.hdr” file into the “selection” window on the visualization panel and initiate display. 
 
In reference to CT studies, the explanation is similar but acquisition parameter files 
will have extension “act” and raw data files, extension “ctf”. 
 
This process is easier done than explained so you should experiment with this 
naming process to see how it works. 
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VISTA-CT MAIN MENU ITEMS 
 
VISTA-CT MAIN INTERFACE  
  
When you have logged onto VISTA-CT, a menu bar appears at the upper left of the 
VISTA-CT main interface screen (Figure 8) which contains five items: e 
 

 

 
 
 
                          Figure 8.  Main VISTA-CT interface (with a detail of the toolbar).  
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Menu Bar items-- 
 
FILE: This menu contains file management tools, e.g. open, import, etc.  
TOOLS: This menu contains tools for image manipulation and analysis. 
MODE: This menu contains different image display options. 
SYSTEM: The following options are available from this drop-down menu: 

o New Acquisition: Opens another drop-down menu that allows the User 
to  select the type of data acquisition, i.e. PET or CT. Whether the User 
selects PET option or CT option, floating PET interface or CT interface, 
respectively, will be open. In any of these interfaces, acquisition 
parameters can be fixed and afterwards, the acquisition can be started. 

o Reconstruction: Allows the User to select a reconstruction method 
according to the type of acquisition. 

o Timing Options: Allows the User to select timing parameters for certain 
data types. 

o Configuration: basic VISTA-CT configuration parameters and 
User/password management (available only to privileged User). 

HELP: This manual and other information.  
 
A number of icon “buttons” are also visible across the top of the main interface 
screen. Holding the arrow cursor on one of these icons for a few seconds will cause 
the function of that icon to be displayed.  These buttons allow you to rapidly jump 
from one place in the User interface to another, bypassing otherwise intermediate 
steps.  Three of these buttons labeled “ACQ”, “RECON” and “TIMING” are 
particularly important (toolbar detail in Figure 8). When the User presses ACQ 
button, a menu with the same options as New Acquisition (Menu Bar) has got plus 
Close option to close this menu will be shown. If the button that the User presses is 
RECON or TIMING, the menu will have the same options as Reconstruction and 
Timing Options, respectively plus Close. 
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ACQUISITION 
 

 ACQUISITION WORK FLOW 
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PET ACQUISITION  
 
When the PET option (New Acquisition, System, or ACQ, toolbar) is selected, data 
PET acquisition is selected and the “New PET Acquisition” panel appears (Figure 9). 
This panel is divided into two parts, the upper part to entry name of study and select 
option of making a plan, and a bottom part to specify the type of protocol (and 
necessary parameters). 
 

 

 
                  Figure 9. New PET Acquisition interface. 
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NEW PET ACQUISITION INTERFACE 
 
Study Name (directory)—  By pressing the “Browse” button, the User can bring up 
the menu of existing study directories. Single clicking on the identified directory name 
and pressing “OK” will write that name into the “Study Name” window of this panel. If 
a new study directory name is desired, press “New” and type in the desired name 
(“File name” field) and press “OK”. 
 
Path Name—  Full path where study files will be saved. Note that last directory of 
“Path Name” is the “Study Name”. 
 
Comments—  Additional free form text can be entered in this window. For example, 
you might enter the name of the radiopharmaceutical, the amount injected, the weight 
of the animal, etc. to help uniquely identify the study in retrospect. This field is not 
necessary to fill in. 
 
Previous Scout—  If the User check this box, text field labeled “Select Scout” and 
“New Plan” and “Browse” buttons will be sensitive meanwhile “Proceed” button will be 
insensitive. This option lets the User plan an acquisition from a previous acquisition, 
PET or CT, so the User will select the limits of the acquisition on sagittal and coronal 
images of a previous scanogram in next window. 
 
New Scout—  If the User check this box, “New Plan” button will be sensitive 
meanwhile “Proceed” button will be insensitive. This option lets the User plan an 
acquisition from a new scanogram. 
 
Select Scout—  By pressing the Browse button, The User can bring up the menu of 
previous plans. Single clicking on the identified plan name (extension “plan”) and 
pressing “Open” will write that name into the “Select Scout” window of this panel. The 
User can know if the previous plan was a PET or CT acquisition looking at plan name 
(letters between underscores just before number of acquisition).  For example, the 
following plan “RATE_13Feb2007_PET_Acq018.plan” was a PET acquisition and 
“RATE_13Feb2007_CT_Acq019.plan”, a CT acquisition. 
 
New Plan—  By pressing this button, this window will be hidden and a new 
scanogram will be launched or a window with a previous scanogram will be shown. 
After the User presses “Proceed” button of Scanogram window, “Protocol description” 
window will be shown again.  
 
Protocol—  Pressing the button in the “Protocol” window produces a drop-down list 
with the following types of data acquisition: 
 
Static (Emission Scan)—  This option shown in Figure 9 is intended for imaging 
tracer distributions that do not change significantly with time, e.g. the brain distribution 
of FDG after 30 minutes. A single 3D data set spanning the axial FOV can be 
reconstructed from acquisitions of this type. 
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Fixed Frame Dynamic (Emission Scan)—  This option (Figure 10) is intended for 
imaging tracer distributions that are changing in time, e.g. transport of tracer through 
the brain, heart, kidneys, etc. Select the desired fixed frame duration from the drop-
down menu.  All time frames in a “fixed frame” study will be of this selected length. 
 

 

 
Figure 10. Fixed frame duration dynamic scan menu. 
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Variable Frame Dynamic (Emission Scan)—  This option (Figure 11)  is intended 
for imaging tracer distributions whose time variation in the target region is highly 
variable, e.g. a rapid change in heart activity after a bolus injection followed by a slow 
variation in heart activity over a much longer period. 
 

 

 
Figure 11.  Variable frame duration dynamic scan menu. 

 
In order to use this feature, you must first define a custom variable frame rate 
protocol with the desired frame durations.  This “DEFINE VARIABLE FRAME 
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LENGTH PROTOCOL” procedure is accessed by pressing the “TIMING” button on 
the Main VISTA-CT Interface (see TIMING in Table of Contents).  When the 
“VARIABLE FRAME” button is pushed on the NEW ACQUISITION menu, a list of 
these previously user-defined protocol names (extension “vdy”) can be accessed with 
the BROWSE function that will load that protocol. The subsequent variable frame 
study will be executed with the frame durations contained in that protocol.   
 
List Mode—  If you do not wish to specify a fixed or variable frame data acquisition in 
advance, you may select the LIST mode option shown in Figure 11.  LIST mode 
acquires the data generated by VISTA-CT but not in a specific temporal format. You 
can reframe or reformat the same List mode data set non-destructively with different 
frame durations.  You can, for example, create two dynamic image sequences from 
the same data set that differ in their respective frame durations.  After a LIST mode 
data set is acquired you must format these data before image reconstruction into an 
image sequence with known frame durations. This formatting operation is 
accomplished using the “LIST Mode Formatting” menu item accessible through the 
“TIMING” icon on the Main VISTA-CT Interface. 
 
Whole-body (Emission Scan)—  This option (Figure 12) is intended for imaging 
static tracer distributions throughout the whole body.  Enter the number of bed 
positions needed to span the length of the animal you wish to image (usually 3 or less 
for the DT, 6 or less for the ST) and the number of overlap slices (to improve 
statistical precision across the joint between bed positions). Unless otherwise 
specified, the bed will advance with the specified default values.   
 
If the emission scan will have more than one bed position and is to be corrected for 
attenuation using a transmission scan acquired immediately prior to the emission 
scan, check the box labeled “Match tx. scan” (see multi-bed position transmission 
scanning).  After checking the box, select a file (extension “acq”) pressing the 
“Browse” button of the same row as “Match tx. Scan”. The box does not have to be 
checked if only a single bed position is required.  
 
When initiated, whole-body imaging occurs under computer control until complete. A 
contiguous whole-body image will be reconstructed automatically from this acquisition 
type. 
 



 35 

 
Figure 12. Whole-body (Emission Scan) interface. 

 
 
Transmission Scan (Single Bed Position)—  With the animal positioned in the 
scanning field, AND BEFORE ADMINISTRATION OF ANY RADIO-
PHARMACEUTICAL, insert the Ge-68 transmission annulus into the aperture with 
the insertion tool to surround the animal.  Select the Transmission Scan acquisition 
mode (Figure 13) and after filling out the appropriate menu items, begin the scan.  
When a Ge-68 annulus is new, a Transmission scan of 30-60 minutes is usually 
required to obtain adequate statistical precision for attenuation correction.  
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Figure 13. Transmission scan (single bed position) interface. 

   
Transmission Scan (Multiple Bed Positions)—With the animal positioned in the 
scanning field AND BEFORE ADMINISTRATION OF ANY RADIOPHARMACEUTI-
CAL insert the Ge-68 transmission annulus into the aperture using the annulus 
insertion tool to center the annulus axially and around the animal. Select the Multiple 
Bed Position acquisition mode (Figure 14), fill in the required menu items and initiate 
the scan. 
 
Transmission data must be acquired for each corresponding emission bed position if 
the entire emission data set is to be corrected for attenuation using the Ge-68 source.  
For example, if a whole body emission scan is performed with four bed positions, four 
transmission scans must also be performed with the same overlap parameter,  
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number of bed positions and in the same bed positions.  Each of these scans must 
possess sufficient counts to yield an accurate attenuation correction for each bed 
position, i.e. 30-60 minutes per bed position x number of bed positions = total scan 
duration. 
 

 
Figure 14. Transmission scan (multiple bed position) interface. 

 
Blank Scan— “BLANK” scans serve two important purposes on the VISTA scanner: 
first, Blank scans are needed for periodic calibration of the system and, second,  the 
most recent of these Blank scans is used as the Blank scan for attenuation correction 
of emission studies.  With this scheme it is not necessary to acquire a Blank scan for 
attenuation correction of an emission study since a Blank scan with excellent 
statistical properties will already exist from the prior system calibration. 
 
A Blank scan (Figure 15) must be acquired with no objects, including the animal bed, 
in the field-of-view.  With the field-of-view empty, slide the Ge-68 annulus into the 
aperture from the rear of the scanner using the provided cylindrical centering tool to 
axially center the annulus. A Blank scan for every energy window should be run long 
enough to reduce statistical error in the calibration routine (also called “Normalization” 
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in a later section) to an absolute minimum since the quality of all subsequent images 
created by VISTA-CT depends strongly on this parameter. Recommended BLANK 
imaging times for each energy window are shown below.  Note that the lengths of 
these scans depend on the age of the annulus after its calibration date. 
 

              100-700 keV energy window:  12 hours (17 hrs*) (21 hrs**) 
             250-700 keV energy window:  18 hours (25 hrs*) (31 hrs**) 
             400-700 keV energy window:  36 hours (50 hrs*) (63 hrs**) 
 

          *90-180 days after the annulus calibration date 
        **180-270 days after the annulus calibration date 

 
It is important to remember that the Blank scan that is collected applies only to 
studies having the same energy window and Blank scans must be acquired for all 
three energy windows if VISTA-CT is to work properly with all three windows. When 
setting up a BLANK scan, the User must also select the  “Ge-68” option from the 
Isotope menu. 
 
The critical role played by Blank scans in calibrating the VISTA-CT system is 
described in detail in the “Normalization” section of this Manual (see Table of 
Contents) and includes a description of how a fictitious user named “QC” (for “quality 
control”) is created to manage Blank scans acquired over time.  
 

 
Figure 15. Blank scan interface. 
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Whole-body Dynamic (Emission Scan)—  This option (Figure 16) mixes whole 
body and imaging tracer distributions whose time variation in the target region is 
highly variable.  
 
As “Whole-body (Emission Scan)”, this protocol requires that the animal be re-
positioned in exactly the same bed positions for emission imaging as for the previous 
transmission scans.  In order to do so, check the box labeled “Match tx. scan” and 
then enter the WB Dynamic transmission scan filename (extension “acq”) in the 
“Filename” window when it becomes active.  Doing so “tells” the Whole Body 
Dynamic (Emission Scan) acquisition protocol to access the bed position data 
recorded during the “Transmission Scan (Multiple Bed Positions)” and to use these 
same bed positions for the WB Dynamic emission study (and all other parameters as 
well). 
 
The User must first define a custom variable frame rate protocol for Whole_Body 
Dynamic with the desired frame durations. This “DEFINE DYNAMIC WHOLE BODY 
PROTOCOL” procedure is accessed by pressing the “TIMING” button on the Main 
VISTA-CT Interface (see TIMING in Table of Contents).  When the “VARIABLE 
FRAME” button is pushed on the NEW ACQUISITION menu, a list of these previously 
user-defined protocol names (extension “wdy”) can be accessed with the BROWSE 
function that will load that protocol. The subsequent variable frame study will be 
executed with the frame durations contained in that protocol.   
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Figure 16. Whole Body (Emission Scan) interface. 
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Isotope— Clicking on this selection will produce a drop-down menu of isotope 
selections (Figure 17).  Pick the isotope you are using for the study.  Time-activity 
curves generated from a data set will be corrected for the radioactive decay of the 
isotope selected from this menu.  These decay corrections are made relative to the 
time that the data collection started, i.e. for the elapsed time after the collection was 
initiated. 
                       

 
Figure 17. Drop-down menu for correction of radioactive decay. 
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Study duration—Enter the total imaging time for the study regardless of type.  The 
total length of a dynamic study is the duration of each frame times the number of 
frames.  The total length of a whole-body scan is the dwell time per bed position 
times the number of bed positions. 
 
Energy window— Three options are available in the drop-down menu shown in 
Figure 18 for the range of absorbed photon energies declared to represent valid 
coincidence events. The default range is 250-700 keV, a window that gives medium 
sensitivity (4.0% DT, 2% ST) and moderate scatter rejection.  The narrowest range 
(400-700 keV) has the lowest sensitivity (2% DT) but better scatter rejection. The 
widest range (100-700 keV) has the highest sensitivity (6% DT, 2.6% ST) but poorer 
scatter rejection. 
 

 
Figure 18. Acquisition interface illustrating drop-down energy menu. 
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Plan— This button is sensitive when the User has made a plan, ie. he/she has 
selected the limits of the acquisition on Coronal and Sagittal images of a scanogram. 
Pressing this button causes to go back to the made plan.  
 
Proceed—Pressing this button causes VISTA-CT to accept all entries in the New 
PET Acquisition panel and move to the next panel in the data acquisition process 
shown in Figure 19.  This panel shows the progress of the data acquisition and 
reports important attributes of the ongoing data collection, e.g. coincidence rate, etc. 
The study name, type of acquisition, the isotope and the energy window are also 
displayed along the top of this panel. 
 

 

 
Figure 19. Acquisition Start/Stop interface 

 
 
Close (System Menu)—  Pressing this button deletes the New PET Acquisition 
panel, current plan (if it applies) and all entries. 
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After pressing “New Plan” button with “New Scout” box selected, the window which 
will be shown is that whose title is “Steps for the Scanogram Process” (Figure 20). 
 

Figure 20. Steps for the Scanogram Process interface. 
 

 
STEPS FOR THE SCANOGRAM PROCESS INTERFACE 
 
Ini—  Prior to press the “Ini” button, the User moves the bed to its initial position and, 
then, the User will press “Ini” button. Note that using laser beam is a better way to fix 
this position.  
 
End—  Prior to press the “End” button, the User moves the bed to its end position 
and, then, the User will press “End” button. Note that using laser beam is a better way 
to fix this position. If the User doesn´t move the bed after pressing “Ini” button, the 
size of the scanogram will be one single bed. If the distance between initial and end 
position isn´t a whole multiple of CT bed size, the size of the scanogram will increase 
up to the distance is a whole multiple. 
 
Scout—  If the User press this button, the acquisition of the scanogram will be 
launched. While the acquisition is carrying out, X-Rays notice will be ON. 
 
Cancel—  Except while the acquisition is carrying out, if the User presses “Cancel” 
button, this window will be deleted and “New PET Acquisition” panel will be shown. 
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After pressing “New Plan” button with “Previous Scout” box selected or finishing 
scanogram acquisition, the window which will be shown is that whose title is 
“Scanogram Protocol” (Figure 21). 
 
 
SCANOGRAM PROTOCOL INTERFACE 
 

Figure 21. Scanogram Protocol interface for PET acquisition                 
(with a previous CT plan). 

 
PET Parameters—  The User can modify the following parameters when he/she 
desires to acquire PET data. Thus, the User can select what he/she wants to acquire. 
 
Z_position—  Pressing Plus or Minus buttons, the User moves the bed position 
along axial axis. 
 
Bed Positions—   This text field shows the number of beds of the acquisition. The 
User can just modify this parameter in the “New PET Acquisition” window. Each bed 
will be shown with a different colour. For example, in Figure 21, first bed is 
represented as a yellow rectangle and second bed, as a red rectangle. 
 
Overlap—   This text field shows the overlap in mm among beds. The User can just 
modify this parameter in the “New PET Acquisition” window. 
 
Proceed—   Pressing this button will close this window and will show “New PET 
Acquisition” window if PET acquisition is or “NEW CT Acquisition” if CT acquisition. 
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If the User has selected a previous plan, the type of plan will be shown in the right 
upper corner. For example, in Figure 21 the previous plan was a CT plan. In addition, 
the limits of this previous plan will be shown (grey lines). 
 
 
ACQUISITION START/STOP INTERFACE 
 

Figure 22. Acquisition Start/Stop interface. 
 
Note that the “Center” button will be sensitive just when the User make a PET 
acquisition without a plan.  
 
When a positron-emitting object appears in the field-of-view after the CENTER button 
is pressed, the top portion of this panel will display an axial “persistence” projection 
image of the field-of-view as if you were looking down through the top of the gantry at 
the animal lying on the imaging bed.  This image is a “projection” in the same way 
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that a chest x-ray is a projection of the chest onto a piece of film or that a gamma 
camera image is a planar representation of activity in the field-of-view.  The third, or 
depth, dimension in these images is collapsed onto a plane and lost but the 
distribution of activity in the two-dimensional plane is acquired at much higher 
sensitivity than a tomographic image.  This persistence image is continually refreshed 
at 10 second intervals allowing changes on this time scale to be visualized. 
 
Note that this image is intended primarily as a Quality Control aid.  The way that this 
image is formed causes the appearance of an object to be dependent on the 
thickness of the object, the distribution of tracer in the animal and on the vertical 
position of the object in the field of view.   As a result, you should regard this 
persistence image as a relatively crude representation of the actual tracer distribution. 
 
By way of example, the image shown in Figure 22 is that of a rat head containing F-
18 FDG. The animal’s nose is at the top of the image, the Harderian glands are the 
bright spots left and right and the brain is the larger, diffuse structure towards the 
bottom of the image. While anatomical detail is relatively poor in this image, it is clear 
that the brain is within the axial FOV and that the animal is correctly positioned for 
imaging the head and brain (one of the purposes of this kind of display). More 
generally, this persistence image can be used to guarantee that any pre-labeled 
organ is in the FOV before imaging. 
 
The status of the data acquisition process is updated on the panel below the 
persistence image.  Elapsed time, coincidence rate, singles rate, randoms rate, total 
coincidences in the current frame, current time frame number (if dynamic study), 
current bed position number (if whole body scan) are all shown during data 
acquisition.  The time-of-day of the start of acquisition and the estimated time to 
completion are also shown. 
 
When this panel first appears, CENTER, START and EXIT are active but are shown 
as inactive in Figure 22.  At this point you should place the animal on the imaging 
bed, move the animal forward with the hand controller until the laser illuminator is 
directly over the center of the imaging target and then click on CENTER.  With this 
command, VISTA-CT automatically moves the animal forward into the aperture to 
place the laser-designated target point exactly at the center of the axial field-of-view. 
This action will also initiate the persistence image acquisition. 
 
Before initiating bed movement you should make certain that the animal or imaging 
target is vertically centered in the aperture using the manual screw drive and that the 
animal or any attached equipment will actually pass into the aperture without hitting 
the gantry.  Remember that if a transmission study is also to be done, the animal and 
bed must also pass through the transmission annulus when it is positioned in the 
aperture.  If you are unsure this will happen, it may be useful to manually drive the 
animal into the aperture with the transmission annulus in place before starting 
imaging to make sure the animal and bed won’t hit the annulus. 
  
Once the animal has been inserted properly using the CENTER command, hitting the 
START button will initiate the acquisition and the status panel will appear as in Figure 
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22.  After 10-15 seconds the status panel will begin to update as data are 
accumulated. When the START button is pressed, the current active buttons are 
turned off and the END and ABORT buttons become active as shown in Figure 22. 
The acquisition will continue uninterrupted until the stop conditions are reached.  The 
status panel will then signal that the acquisition is done at which point you can press 
the active EXIT button to store the acquired data and return to the main menu.      
 
If something goes wrong during an already started acquisition, e.g. the animal moves, 
etc., you may stop the acquisition in one of two ways (Figure 22).  First, you can END 
the acquisition.  If END is selected, the acquisition terminates and all data acquired to 
that point are saved.  If ABORT is selected, data acquisition ends but the file is 
deleted and the data discarded. These two modes give you the option of saving a 
study that is almost finished when something goes wrong or throwing away a study 
that is made truly useless by some misadventure, e.g. animal movement early in a 
study  compared to animal movement during the last frame of a two-hour study. 
 
As suggested earlier, you can use these same features to center a pre-labeled organ 
in the axial FOV.  If after CENTERing the axial position of the organ appears incorrect 
by inspection of the persistence image, you can press ABORT and repeat the 
CENTERing procedure accounting for the change you wish to make in the axial 
position of the organ. Once satisfied that this position is correct, you can START the 
data acquisition.   
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CT ACQUISITION  
 
When the CT option (New Acquisition, System, or ACQ, toolbar) is selected, data 
CT acquisition is selected and the “New CT Acquisition” panel appears (Figure 23). 
This panel is divided into two parts, the upper part to entry name of study and select 
option of making a plan, and a bottom part to specify the type of protocol (and 
necessary parameters). 
 

 

 
                  Figure 23. New CT Acquisition interface. 
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As the upper part of “New PET Acquisition” and “New CT Acquisition” are equal, 
these fields won´t be explained next. 

 
 

NEW CT ACQUISITION INTERFACE 
 
 
Study Name—  See “New PET Acquisition” Interface. 

 
Path Name—  See “New PET Acquisition” Interface. 
 
Comments—  See “New PET Acquisition” Interface. 
 
Previous Scout—  See “New PET Acquisition” Interface. 
 
New Scout—  See “New PET Acquisition” Interface”. 
 
Note that when “Previous Scout” is checked, “New Scout” isn´t and the opposite way. 
The “Proceed” button won´t be sensitive unless the User make a plan. 
 
Select Scout—  See “New PET Acquisition” Interface. 
 
New Plan—  See “New PET Acquisition” Interface. 
 
Protocol—  This option isn´t available in this version. 
 
X-Rays—  The User can select the current and voltage of X-Rays through these 
sliders after the plan is made. 
 
Projections dimensions—  The User can select number of projections (droplist 
“Num_Projections”), number of shots (“Num_shots”) and pixel size (“Pixelsize”) 
after the plan is made. In addition, the size of a single bed in axial axis (text field 
“Proj_size_z”) and in the other axis (text field “Proj_size_x”) in mm, the total size of 
the acquisition in mm (text field “Image Size”)  and in pixels (text field “Projection 
Size”), the number of beds (text field “Bed Positions”), the overlap between beds in 
mm (text field “Overlap”) and the initial position of the study (text field 
“Initial_position”) will be shown after the plan is made. 
 
The possible values of “Num_Projections” are 360, 720 and 1080; “Num_shots”, 
1,2,4,8,16 and 32 (although possible values depend on value of “Num_projections”)  
and “PixelSize”, 50, 100 and 200. 
 
Acquisition estimation duration—  This label shows an estimation of the 
acquisition duration after the plan is made.  
 
Plan—  See “New PET Acquisition” Interface. 
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Proceed—  When the User press this button, the CT acquisition is launched,  “New 
CT Acquisition” interface is hidden and “Acquisition Start/Stop” interface is shown. 
This button is sensitive when the plan is made. 
 
 
After pressing “New Plan” button with “New Scout” box selected, the window which 
will be shown is that whose title is “Steps for the Scanogram Process” (see PET 
Acquisition). 
 
If the User presses “New Plan” button with “Previous Scout” box selected or finishing 
scanogram acquisition, the window which will be shown is that whose title is 
“Scanogram Protocol” (Figure 24). 
 
 

SCANOGRAM PROTOCOL INTERFACE 
 
 

 
 

Figure 24. Scanogram Protocol interface for CT acquisition                 
(with a previous PET plan). 

 
 
CT Parameters—  The User can modify the following parameters pressing minus or 
plus buttons when he/she desires to acquire CT data. Thus, the User can select what 
he/she wants to acquire.  
 
Proj_size_x—  This field shows the size in mm of a single bed along X or Y axes. 
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Proj_size_z—  Size in mm of a single bed along axial axis. 
 
Z_position—  Pressing Plus or Minus buttons, the User moves the bed position 
along axial axis. 
 
Bed Positions—   This text field shows the number of beds of the acquisition. Each 
bed will be shown with a different colour. For example, in Figure 24, first bed is 
represented as a yellow rectangle and second bed, as a red rectangle. 
 
Overlap—   Overlap in mm among beds.  
 
Proceed—   See PET Acquisition. 
 
If the User has selected a previous plan, the type of plan will be shown in the right 
upper corner. For example, in Figure 24 the previous plan was a PET plan. In 
addition, the limits of this previous plan will be shown (grey lines). 
 
 

ACQUISITION START/STOP INTERFACE 
 

 
Figure 25. Acquisition Start/Stop interface for CT Acquisition. 
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Figure 25 shows Acquisition Start/Stop interface for CT Acquisition.  In the upper part, 
the User can see the acquisition parameters: name of the study (PATIENT), current 
and voltage of X-Rays (CURRENT and VOLTAGE, respectively), the value of the 
binning chosen (BINNING), the number of beds (BEDPOSITIONS), the number of 
shots (NUMBER_SHOTS), the size of a single bed in pixels (PROJ_SIZE_AXIAL for 
size along axial axis and PROJ_SIZE_RADIAL for size along X or Y axes), the value 
of overlap in mm (OVERLAP) and the number of projections 
(NUMBER_PROJECTIONS). 
 
In the middle of the panel, Starting time and Acquisition Time left (after finishing 
Calibrating Images) are shown.  
 
In the bottom part of the panel, the User can see the current values of Elapsed time 
in sec, Bed Position, Projection Number and Angle. 
 
While the acquisition is carrying out, X-Rays notice will be ON. 
 
Abort—  Pressing this button will cancel the acquisition. After several seconds, “Exit” 
button will be sensitive. 
 
Exit—  If the User presses this button, Acquisition Start/Stop Interface will be deleted, 
showing “New CT Acquisition” interface if the User has pressed “Abort” button or 
VISTA-CT main interface screen if the acquisition has finished without any problems.  
 
Hide Window—  While the acquisition is carrying out, the User can continue with 
other tasks after pressing this button. To go back to this panel, press CT option in 
New Acquisition (System) or in ACQ (toolbar). 
 
 
 
If during the acquisition, an error happens, the acquisition will be aborted, an error 
message will be shown and after pressing “OK”, “New CT Acquisition” interface will 
be shown. 
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RECONSTRUCTION 
 
PET RECONSTRUCTION 
 
If the “Reconstruction” option in the drop-down “System” menu is selected or the 
“RECON’ button pressed on the Main Interface, two-dimensional filtered 
backprojection (2D FBP) and two-dimensional ordered subset expectation 
maximization (2D OSEM) become available for image reconstruction after pressing 
PET or PET_RECON option, respectively. Both of these reconstruction algorithms 
operate on 2D sinograms created with the FORE algorithm (Fourier RE-binning 
algorithm) from the 3D data sets acquired by VISTA-CT. This algorithm permits the 
optimal amount of 3D data to be used in the reconstructions.  Direct user access to 
these sinograms is described in Appendix E. 
 
2D FBP reconstruction—Local 2D FBP reconstruction (Figure 26) is initiated by 
selecting “BROWSE” and entering 
 

 
                              
                         Figure 26.  3D FORE/2D FBP reconstruction menu. 
 
              
the desired “.acq” filename into the Study acquisition file box. This action will 
automatically create a Reconstructed image filename by replacing the “.acq” 
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extension with the “.hdr & .img” suffix indicating that the output file is now a 
reconstructed image sequence rather than raw data. 
 
Dmax (Ring Difference)—The VISTA detector array consists of “rings” of scintillation 
crystals and it is coincidences between adjacent rings that allow 3D data to be 
acquired.  Dmax is defined as the maximum number of rings that are allowed to be in 
coincidence with one another.  For example, the VISTA DT has 32 effective rings so 
that the maximum ring difference, N, is 31, i.e. 32 – 1 = 31, one ring in coincidence 
with the 31 other rings.  A ring difference less than 31 will limit the range of 
coincidence lines to a smaller number but with less steep lines-of-response.  Image 
data acquired with the VISTA DT can be reconstructed only if N>10 and in the range 
10 <N<31 (16 is the recommended default ring difference for the DT). The VISTA ST 
will accept ring difference values in the range 0<N<12 since there are 13 rings of 
scintillators. The default ring difference for the ST is 12 since the axial field-of-view is 
less than the DT and none of the 3D lines-of-response are particularly “steep”. 
 
Since FBP reconstruction starts with 2D sinograms created with the FORE algorithm, 
you must enter values for Span and Dmax that control the FORE re-binning process.   
 
While it might seem that one would always want the largest ring difference (to use the 
most 3D data), a price is paid for accepting all coincidence lines.  As the “steepness” 
of the lines-of-response in the axial direction increases, axial “blurring” of objects in 
the field of view becomes more pronounced.  As a result, for 3D machines with a 
large axial field-of-view, some upper limit less than the maximum ring difference must 
be selected unless axial resolution is unimportant in the study at hand. The default 
values for Dmax that appear when the RECON menus is selected are reasonable 
compromises between these choices. 
 
Span—Span refers to the degree of axial angular compression of lines-of-response.  
Larger values for span will combine a greater axial angular range of lines-of-response 
and, ultimately, increase axial blurring.  The default value for span that appears in the 
interface is a good choice for most imaging studies. 
 
FBP Filter--Once the file names have been established, you may select the kind of 
filter to be used in the reconstruction (Ramp, Hanning,…) and the properties of that 
particular filter (Alpha and Cutoff).  Default values are supplied for each of these 
parameters that under most circumstance give reasonable reconstructions. 
 
2D OSEM reconstruction-- As with FBP, you must identify the .acq file to be 
reconstructed and select the FORE parameters described above in the 2D OSEM 
menu shown in Figure 20.  Once the FORE parameters have been selected, you can 
choose the number of subsets into which the calculation is divided and the number of 
approximating iterations.  The default values supplied on the 2D OSEM menu (DT 
values in Figure 27) will give reasonable (and rapid) results for most studies but you 
should experiment with these values to ascertain the consequences of using different 
values. 
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                      Figure 27.  3D FORE/2D OSEM reconstruction menu. 
 
                             
Filtered backprojection is a fast, analytical method for reconstructing an object from 
its projections and runs rapidly on the VISTA-CT workstation (approximately 90 
seconds for a reconstruction of 61 slices including FORE).  Given this reconstruction 
speed, FBP can serve not only as a final reconstruction method, but also as a QC 
procedure to check the validity of any given data acquisition when a study is finished.  
On the other hand, 2D OSEM gives the option of invoking “resolution recovery” but at 
the expense of an increased reconstruction time (albeit not a large increase: <3 
mintues/61 slice data set including FORE).  This difference in reconstruction times 
suggests a strategy where FBP is used primarily for quality control at the end of each 
data acquisition but where OSEM is used for final image reconstruction when there is 
little or no time pressure for machine access, e.g. overnight. This difference is 
particularly acute if the 3D OSEM (remote) option is available since reconstruction 
times with this algorithm are far greater than with either method provided “locally” on 
the VISTA-CT workstation.  It should also be borne in mind that image reconstruction 
and data acquisition can proceed simultaneously on the VISTA scanner since image 
reconstruction is carried out on the VISTA-CT workstation while data acquisition is 
controlled by a separate data acquisition computer.  Note also that 2D OSEM is 
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implemented on the VISTA-CT workstation and that resolution recovery occurs only 
in the transverse plane, not in the axial direction. 
 
Corrections— 
Three additional buttons are provided under “corrections” that allow you to choose 
which corrections are applied during the reconstruction process. In “real” imaging 
studies implementing these corrections can add unacceptable statistical  “noise” to 
the reconstructed images or add significantly to the computational time or to the 
length of the imaging study itself, e.g. added time to perform the transmission scans.  
Scatter and attenuation in mouse-sized objects, for example, are not large effects and 
it is sometimes possible to ignore these corrections, which if applied, might increase 
image noise and the length of the scanning session without improving (or actually 
decreasing) quantitative accuracy. As a result, you have the option of using or 
ignoring these corrections as conditions permit. 
 
Randoms correction and scatter correction are independent processes that can be 
invoked individually or together for any data set. You can simply check one or both of 
these boxes and the identified correction(s) will be made.  Attenuation correction, on 
the other hand, requires: (1) a pre-existing transmission scan acquired immediately 
before the corresponding emission scan, (2) correction for scatter and (3), if needed, 
correction for randoms (recommended).  That is, if you wish to correct an emission 
data set for attenuation, the scatter and attenuation boxes must be checked (and the 
Randoms box also for consistency).  If Attenuation correction is checked and the 
Scatter correction box is not, or if there is no previously acquired transmission scan, 
reconstruction will not be permitted.  Correction for attenuation proceeds by first 
correcting the 2D FORE sinograms for random coincidences, then for scatter and 
finally for attenuation.  It is not possible to apply an attenuation correction without first 
correcting for scatter since attenuation correction of sinograms that contain scatter 
will lead to quantitatively inaccurate reconstructions. 
 
Randoms Correction—Selection of this item will cause the reconstructed  images to 
be corrected for random coincidences.  A computational method is used to make this 
correction, rather than “delayed coincidence”, that uses the measured singles rate on 
each crystal and the coincidence timing window for a given crystal pair (line-of-
response or LOR) to calculate the random coincidence rate for that LOR. This 
calculated number of random events for each LOR is subtracted from the number of 
events recorded for that LOR to obtain a randoms-free measurement of coincidence 
rate along that LOR. This random coincidences correction is applied to all LORs and 
removed from the data before image reconstruction. 
 
Scatter Correction—Scatter in small laboratory animals, e.g. rats and mice, while a 
smaller effect than in humans subjects, still represents a significant fraction of the 
total events detected by most small animal PET scanners. Scatter fractions for 
rodent-sized test objects range from about 15% (mice) to 45% (rats) depending on 
instrument and energy window. The amount of scatter actually acquired during data 
acquisition can be substantially reduced by choosing a narrow energy window for a 
study, e.g. 400-700 keV, rather than the usual “default’ window of 250-750 keV, but at 
the expense of substantially reduced sensitivity. Conversely, a wider energy window, 



 58 

100-700 keV, will exhibit higher sensitivity so that smaller amounts of tracer can be 
administered while preserving count rate (important when imaging brain receptor 
ligands) but at the potential expense of quantitative accuracy.  There is no hard and 
fast rule about how these energy window should be set so you should experiment 
with different energy windows with and without applying the scatter correction routine 
described below. 
 
Scatter correction is applied to the FORE sinograms before reconstruction with either 
FBP or OSEM.  Here, the count profile in each line of a sinogram is fit with a straight 
line that uses only points in the profile near the edges of the field-of-view for the fit, 
i.e. ignores the counts actually in the object.  The counts represented by this best fit 
line are then subtracted from the count profile to remove the scatter contribution.  
This process is repeated for each line in the sinogram, for all 61 (25) sinograms 
(slices) in each data acquisition and for all data acquisitions over time (dynamic 
scans) or space (whole-body scans).  It is useful to note that this method provides a 
first order correction not only for scatter but also for the LSO background present in 
the scanner and for multiple gamma ray coincidences that occur when imaging 
certain “non-traditional” radionuclides such as I-124. The supplied scatter correction 
can be used effectively in all of these circumstances and is recommended for routine 
use. 
 
Attenuation Correction—If an emission scan has been immediately preceded by a 
transmission scan, the emission scan can be corrected for attenuation.  First, you 
must submit the transmission scan to either the FBP or 2D OSEM menus as a regular 
.acq study where the entries in both menus are made to be identical to those that will 
be used to reconstruct the emission scan.  These transmission data are then 
reconstructed into CT-like images with the selected algorithm that portray the 
distribution of attenuating material within the field-of-view.  The User can (and should) 
view these attenuation images before applying the correction (using the Visualization 
and Analysis tools) to insure that the image data have been properly segmented.  
After creation, the names of these CT-like images will contain the abbreviation _seg 
to help identify them as different from regular emission images. 
 
These images are calculated by first locating the most recent Blank scan (done 
automatically), dividing this scan by the acquired transmission scan and then 
computing and displaying the logarithm of these ratios.  These images are 
segmented by setting all values greater than a predetermined threshold to unity and 
all values below the threshold to zero.  The effect of this segmentation is to retain 
points in the images where attenuation is appreciable.  These images in transaxial 
view appear to the eye to be cross sectional images of the solid objects within the 
field-of-view, e.g., the animal, the bed. 
 
These segmented images are then retroprojected into count profiles for all projection 
angles in each slice. A sum along a projection line through the object at a given 
projection angle is proportional to the thickness of the object along that projection line 
at that angle. These thickness estimates are then used to calculate an attenuation 
correction factor for every projection line in a count profile assuming a water 
attenuation coefficient at 511 keV.  This correction factor is then used to scale the 
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counts in the randoms and scatter-corrected count profile in the same slice and at the 
same projection angle to correct for events lost due to attenuation. This process is 
repeated for each projection line in a count profile, for all count profiles in a slice and 
for all slices in the data acquisition.   The sequence of events required to obtain 
attenuation corrected emission images is schematically illustrated in the drawing 
below. 

    

Prior Transmission Scan 

Existing Blank Scan

Emission Scan 

Attenuation Correction
Check Randoms Correction

Check Scatter Correction
Name Segmented Image File

SEGmented Attenuation Images

FBP or 2D OSEM
Reconstruction

Attenuation Corrected 
Emission Images

 
This method of correcting for attenuation possesses several virtues.  First, because 
the correction is not a “measured” attenuation correction that uses the counts actually 
acquired during the transmission and blank scans to make the correction, this method 
does not directly propagate statistical “noise” into the corrected emission images.  A 
major deficiency of attenuation correction methods that depend on radioisotope 
transmission sources is that such corrections are “noisy” often to the point where the 
improvement in quantitative accuracy from the correction is offset by the introduction 
of statistical noise.  
 
Statistical noise does, however, indirectly influence the accuracy of the segmentation 
process so it is still necessary to “smooth” the acquired transmission data prior to 
segmentation.  If the attenuation images are created with FBP, you should select a 
HANN filter for reconstruction to smooth these data.  If you choose 2D OSEM, you 
should choose one iteration for reconstruction rather than the default value to achieve 
the same effect.  
 
Finally, it should be borne in mind that this attenuation correction method assumes 
that the attenuation coefficient of matter within the field-of-view is water-like so that 
regions with differing, non-zero attenuation coefficients will not appear different from 
one another.  While a uniform attenuation coefficient is clearly an assumption, it is a 
plausible assumption since small animals are comprised mostly of soft tissue along 
almost any given projection line. 
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Normalization using the FBP reconstruction menu-- You will need to perform one 
or more BLANK scans with the Ge-68 annulus either after a shutdown of the system, 
or periodically, in order to maintain good system calibration.  The purpose of these 
scans is to define calibration factors that are used to normalize each line-of-response 
to the same apparent sensitivity for each energy window.  Since there are a very 
large number of these lines, these scans of the Ge-68 annulus must each be carried 
out for extended periods, e.g. 12 hours on more. Once these data sets are acquired, 
one for each energy window, the sensitivity correction factors for each crystal pair are 
re-calculated and stored as a new look-up table that will be used until the next 
update. 
 
To use this feature, an “artificial” user named “QC” (for “quality control”) initiates a 
very long BLANK data collection through the New Acquisition Protocol interface.  
This user name “QC” is reserved exclusively for this normalization procedure and 
should never be used for any other data collection.  
 
When this collection is done, user QC selects the 3D FORE/2D FBP menu in Figure 
26, supplies the study acquisition filename and starts the “reconstruction”.  Since, 
however, this file was generated by user QC, the data will not be reconstructed.  
Instead, when this computation is complete, a new table of normalization factors will 
be created that replaces the old table and that will be used from then on until 
replaced by data from the next BLANK (normalization) scan.  These normalization 
factors do not depend on the other items listed in the menu and only a “Study 
acquisition file” name must be entered.  When the “START” button is pushed, the 
other entries are ignored.  Note that no output is produced during calculation of these 
normalization factors: the process simply runs to completion and STOPs.  
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CT RECONSTRUCTION 
 
If the “Reconstruction” option in the drop-down “System” menu is selected or the 
“RECON’ button pressed on the Main Interface and then, the User presses CT or 
CT_RECON option, respectively, the Reconstruction Interface will be shown (Figure 
28). 
 

Figure 28. Reconstruction Interface (CT). 
 
 
Pressing Browse button, the User can select an acquisition parameter file (extension 
“act”) to reconstruct the image acquired previously. After this action, the Reconstruct 
interface will look as Figure 29 if the number of beds of acquisition was greater than 
one and as Figure 30 if the acquisition was of a single bed. 
 
 

Figure 29. Reconstruction Interface (CT, multiple beds). 
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Figure 30. Reconstruction Interface (CT, a single bed). 
 
The difference between Figure 29 and Figure 30 is that the User can see two images 
(Sagittal and Coronal Images) of the image that he/she desires to reconstruct. In 
addition, just in acquisitions of a single bed, the User can select a ROI of the image. 
To do this, the User places the mouse on any of the images (Sagittal or Coronal), 
presses left button and without releasing (a yellow rectangle, which represents the 
selected ROI, will be shown), moves the mouse to the right position (Figure 31).  
 
Text fields X(mm), Y(mm) and Z(mm) will shown the limits of the image which will be 
reconstructed and Image Size, the size of the final image in pixels. 
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Figure 31. ROI selected. 
 
There are several options which aren´t available in this version: Method of 
reconstruction, Corrections (Bean Hardening, Scatter, Ring Reduction, SmoothAxial 
and SmoothVertical). 
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The binning of the reconstruction can be modified through Reconstruction Binning 
droplist (possible values: 1, 2, 4, 8 and 16). Increasing binning will reduce 
reconstruction process duration, size of final image but will make worse spatial 
resolution of the image. 
 
If the User checks Symmetric, the ROI will be symmetric along axial axis regarding 
the center of the two images (Sagittal and Coronal), so the ROI’s in both images will 
be the same (Figure 32). 
 

Figure 32. Symmetric option. 
 



 65 

To start the reconstruction, press “Start” button. The percentage of reconstruction 
progress will be shown next Start button (Figure 33). 
 

Figure 33. Reconstruction in progress. 
 
While the acquisition is carrying out, the User cannot abort the process but can 
continue with other tasks after pressing “Hide” button. To go back to this panel, press 
CT option in Reconstruction (System) or CT_RECON option in RECON (toolbar).  
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When the reconstruction has finished, the image will be shown in VISTA-CT main 
interface (Figure 34) and the User can save by pressing “Save” button or “Save” 
option of menu “File’ (VISTA-CT main interface). If the User doesn´t save the image, 
it will be lost. This is another difference with PET reconstruction where the image is 
saved automatically but the User doesn´t select image name as in CT reconstruction. 
 

Figure 34. Reconstruction finished. 

 
To close this interface, press ‘Close’ button. 
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TIMING  
 
In addition to ACQ and RECON, TIMING, can also be selected from the Main   
VISTA-CT Interface that produces the menu shown in Figure 21.  

 

        Figure 21.  TIMING options available through the Main VISTA-CT Interface. 

The purpose of these timing options is to allow you to retrospectively reformat LIST 
mode data sets into sequences having User defined frame durations and to define 
protocols that allow variable frame rate dynamic studies to be acquired according to 
your specifications.  

LIST mode formatting—When this item is selected from the “options” menu in 
Figure 21, the screen shown in Figure 22 appears.  The User identifies the List 
mode data set with the BROWSE function but the output filename continues to have 
the appended “.acq” designation. This output data set is still in .acq form since LIST 
mode reformatting only transforms the data set into raw data blocks with USER 
specified durations.  Once this sorting operation is completed, the reformatted raw 
data set can be submitted for RECON with any of the available methods. 
 
Figure 22 shows the List mode reformatting menu after the User has selected the 
List mode data set to be reformatted, the output file name has been created and the 
User has selected an already existing dynamic protocol for formatting (named “Rat-
Brain…) from the protocol name file.  The BROWSE functions are inactive showing 
that the algorithm is running and that at this moment, about one-third of the data have 
been processed.  When reformatting is complete, the CLOSE button becomes active 
and the User can leave this menu to continue processing this data set.   
 
If there were no pre-existing protocol with the variable frame durations needed by the 
User, the User would first select “Define variable frame length protocols” from the 
menu shown in Figure 21.  This selection yields the menu shown in Figure 23. 
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                          Figure 22.  List Mode Formatting menu. 
 
Define Variable Frame Length Protocols—If this item is selected from the TIMING 
menu, first enter a descriptive name for the variable frame length protocol about to be 
created.  
 
Since these protocols can be easily retrieved by name, they should be given names 
that are associated with the study type and investigator (for example) that are easily 
remembered and/or recognized. 
 
The procedure for filling out the protocol “form” is illustrated in Figure 23. You can 
define up to 9 different time “blocks” where each block can contain a different number 
of frames with a given (but different) frame duration.  In the example shown in Figure 
23, 6 has been entered for the number of frames in time block #2 and 30 seconds for 
the length of each of these frames.  This means that after 120 seconds (after 
completing acquisitions directed by time block #1), a series of 6 consecutive frames 
will be acquired, each 30 seconds long.  At the end of this interval (300 seconds after 
the start of the study= 120 + 180 seconds), control will pass to the third time block 
and so on until all filled-in time blocks have been exhausted. 
 
For convenience, the total amount of time spent in each time block is shown at the 
right of the menu and is continually updated as you fill in the numbers.  The sum of 
these times, the “total study duration” is shown at the bottom of the form and is the 
time required to execute the entire protocol.  This feature, which is also continually 
updated with each new entry, is useful in that you can experiment with different time 
entries in each block and use this sum to insure that the total study duration is not 
excessive.   
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                    Figure 23.  Define Variable Frame Length Protocols menu. 
 
Protocols defined in this way can be “called” from the New Acquisition menu to guide 
a variable frame rate acquisition or, as shown here, called to guide reformatting of 
LIST mode data prior to reconstruction. 
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VISUALIZATION AND ANALYSIS 
 
After a raw data set is reconstructed, you can utilize the File, Tools and Mode items 
in the VISTA-CT toolbar to analyze and display these images. 
 
File menu 
Image input/output: 
 
Clicking on File will produce a drop-down menu with Open, Import, Close, View, 
Save, Save As, Close All and LogOut. 
 Clicking on Open will allow the User to select the file for display.  Image files 
are always opened with File->Open button. The opened image file will be written to 
the image stack, that is the group of images that are loaded from VISTA-CT 
(maximum 15 images).  
 The File->View button is used to select which image from the stack is on 
display.  
 Any image from the image stack can be closed using File->Close button, 
selecting the right image from the button list.  
 The File->Close All button is used to close all the images that have been 
opened. The File->LogOut button allows the user to finish the session.  
 The File->Import button is used to open images that have been stored in other 
formats, such as DICOM or RAW.  
When File->Import->DICOM button is pressed, the user is prompted to select a 
single image from the folder where the whole DICOM image series is stored. The 
system will search for all the images belonging to the same series and load them in 
the image stack. When File->Import->RAW button is pressed, the window displayed 
in Figure XXX will appear. 
 

 
    Figure XXX. Import RAW data menu. 
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RAW images are those stored in a single file that only contains pixel values. In order 
to properly read a RAW file, the user must select the image file using Browse button 
and insert the X, Y and Z image dimensions in xsize, ysize, zsize fields. Pixel values 
data type, byte-swapping option, byte offset or pixel sizes must be also selected. 
Preview button allows displaying how the image 2D slices will be read using those 
user defined values. PROCEED button will finally load the resulting image in the 
stack. 
 
DICOM--The “Save As” item in the File menu allows reconstructed images to be 
exported in DICOM format (Figure 25) by selecting the File->Save As...->DICOM 
path.  

 

 
Figure 24. Exporting to DICOM. 

 
When this option is selected, you must create a folder in which to save the images 
and a name for the images in that folder. All these files will have the extension .dcm 
added to the name and these will be appended with 000, 001, 002, ..., 060 to 
distinguish images from one another. 
 
Once a file is selected with Open from the File menu, it is immediately loaded and 
displayed to the User on the screen shown in Figure 21 in the default “Stack” mode. 
There are four different visualization modes inside the Analysis & Visualization 
Interface: Stack, Montage, Dual View and Analysis. You can switch freely between 
different modes at any time using the Mode menu and icon combinations that are 
always present.  
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The following features are common to all the Analysis & Visualization modes. 
Tools menu 
 
Window / Level—This button opens a floating interface to manipulate the brightness 
(level), contrast (window) and color palette of the displayed image.  
 

 
 
                                 Figure XXX. New Figure Window / Level. 
  
Volume Rendering Tool— Pressing the RENDER button allows creation of a three-
dimensional representation of a two-dimensional image stack. The rendering “quality” 
and type can be selected. The difference among the three quality options is the size 
of the rendering window (the size of the volume to be rendered) and consequently the 
rendering quality and time needed to render. Rendering type can also be selected.  In 
Figure 25, for example, the User has selected type “MIP” or “maximum intensity 
projection” as the rendering algorithm.  
 
The render manipulation is similar to the animation interface. Every time a rendering 
is created, the previous version is deleted from memory.  The tools described above 
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are available in all modes. Details for every mode are explained in the following 
pages. The resulting render can be saved as a standard AVI movie using SAVE 
button. If select AVI options is checked, the user will be prompted to select the quality 
of the film and the compression method used when creating the movie file. 

 
                                            Figure 25. Rendering tool. 
 
Interactive Render.- The Interactive Render button opens a floating interface where a 
three-dimensional representation of the currently displayed image created. Unlike the 
volume rendering tool, the image can be freely rotated by moving the mouse with the 
left button pressed. The rotation can also be restricted to one axis. The rendering 
quality and type, zoom, image interpolation and window/level settings can be 
modified. The render window and the tri-planar viewer are synchronized, and OV 
axes can be displayed on the render.  
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Figure XXX. New Figure Interactive Render. 

 
 
Interactive render tool allows creating movies of the rotating render by clicking on 
Cine button (New Figure). The rotation axes, total rotation, angle step and total 
number of projections can be selected, and pressing CONTINUE button the movie 
will be rendered. The result is displayed in the same interface as in the standard 
render tool (New Figure), and can be saved form there. 
     

 
 Figure XXX. New Figure. 
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Reformat.- The Reformat button opens a floating interface that allows the user to 
apply different geometrical transformations (translation, rotation, scale, affine, mirror) 
to the image currently displayed. PREVIEW button shows the result of the 
transformation in the OV, while PROCEED finally reformats the image according to 
the selected transformation parameters. Interpolation type (Trilinear or Nearest 
Neighbor), background pixel value and output sizes can also be modified. 
 
 

   
     Figure XXX. New Figure Reformat. 

    

Image Info.- The ImageInfo button opens a floating interface where image information   
is displayed. The image information is classified into six groups: 
   -Patient: patient demographic info (id, sex, age..). 
    -ImgData: features related to how image values are represented. 
   -ImgInfo: general information about the image. 
   -StudyInfo: properties related to the study. 
   -SerInfo: properties related to the image series. 
   -FrameInfo: temporal information only displayed for dynamic studies. 
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  Figure XXX. New Figure Image Info. 
 

Snapshot.- This tool allows the user to capture one of the current image views and 
save the contents to a TIFF (Tagged Image File Format) file. The picture filename 
must be selected using BROWSE button. The capture will be saved when EXPORT 
FILE button is pressed. 
 

 
           Figure XXX. New Figure SnapShot. 
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Stack Mode: 
 
In this mode image “slices” (slice = anatomical image) are displayed on a single 
window and also on the tri- planar viewer (called Ortho Viewer or OV) shown in 
Figure 26. You can freely navigate through the 3D images in the OV by clicking on 
any of the three views. Buttons in the main window (Figure 27) allow the image to be 
zoomed (+Z larger, 0 none, -Z smaller) and to change the view (Axial, Coronal or 
Sagittal).  If the displayed study is dynamic, the Frame slider will also become active 
allowing you to move from one anatomical data set to the next through time (frame = 
moment in time).  
 
 

    

QuickTime™ and a
Graphics decompressor

are needed to see this picture.

 
                                              Figure 26. Stack Mode 
 

           
        Figure 27. Visualization controls for zoom, interpolation and current view. 
 
A Cine display of all slices or frames can be played or stopped (right arrowhead) and 
its speed can be increased (+) or decreased (-) with the controls shown in Figure 28. 
Both main and OV viewing tools have zoom controls (Z+ bigger, 0 none, Z- smaller) 
and image interpolation-Interp. 
 



 78 

                      
                                               Figure 28. Cine tools. 
 
You can also move through the slices (or frames for dynamic images) using the down 
arrow icon shown in Figure 28. 
 
Montage Mode: 
 
In this mode (Figure 29) there is an OV on the right of the interface. On the left all the 
slices are displayed in a single window. This window has Zoom and  

 
  

             Figure 29. Montage Mode showing anatomical slices through object 
 
an Interpolation option and controls that allow the layout of image columns on the 
display to be modified by the User (visible just above the Montage display). A droplist 
allows you to switch the main viewing window from displaying multiple anatomical 
slices (Figure 29) to displaying a sequence of dynamical frames (same anatomical 
slice over time) like those shown in (Figure 30). 
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        Figure 30.  Montage mode used to display a sequence of dynamic frames. 
 
 
Registration Mode: 
 
This mode has two tri-planar ortho-viewers, OV1 and OV2 (Figure 31), to display 
simultaneously two sets of image data. In this mode the buttons inside the File and 
Tools menus are duplicated allowing you to interact with each tri-planar viewer 
independently. Dynamic images can also be displayed and the current frame can be 
selected using the frame droplist. 
 
Registration Tools are also available and include: 
Markers registration-- This registration method requires you to introduce at least three 
correspondent positions in both image sets and then calculates the transformation 
matrix. 
 
MI registration--Using this procedure, the transformation matrix is calculated 
automatically with almost no User interaction. 
 
Join/Unjoin 3D viewers--When both images are registered, the 3D viewers can be 
joined. The axes will be updated at the same time in both. 
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Fused display--This button starts the fusion interface that creates a new image 
combining information from both registered images. 
 
Arithmetics.- This button opens a floating interface that allows different arithmetic 
operations between the two images. Both images can be combined using different 
operators (add, subtract, multiply, divide, raise to the power of a number), and every 
image can also be modified with a scalar value (maximum, mean value of the image 
or a scalar introduced by the user). DO IT button will calculate the result and display it 
in the selected OV. 
 

 
 
    Figure XXX. New Figure Arithmetic. 
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                                             Figure 31. Dual View Mode 
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Each OV contains three cursors that can be moved by dragging or simply by moving 
the mouse icon to a point in an image and clicking.  With this action, the cross-hairs in 
the active image will be immediately re-located to the same mouse icon position in 
both upper and lower image displays.  In this way, a location identified in one image 
set can be transferred to the second set. 
 
Although the Dual Viewer can be used to view any two sets of image data, the Dual 
View mode is primarily intended for comparing two spatially registered data sets.  If, 
for example, a spatially registered CT data set is displayed in OV1 and the 
corresponding PET study in OV2, the anatomical information in the CT study can be 
used to help identify the location of concentrations of activity in the PET study. 
 
 
Analysis Mode: 
 
The Analysis main interface is similar to Stack mode. The procedure to segment and 
analyze one or several regions proceeds by clicking on the Analysis button (Figure 
32). Two floating interfaces will appear over the main screen: ROIs (Regions-Of-
Interest) and SEGMENTATION TOOL. The SEGMENTATION TOOL handles the 
selection of segmentation methods whereas the rest of functions are controlled by the 
ROI interface. 
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         Figure 32. Segmentation floating windows over VISTA-CT Analysis Mode 
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How to begin a segmentation session: 
 
Before beginning a segmentation, a new region-of-interest must first be named by 
pressing the New button in the ROI floating interface, and typing the name of one or 
more ROIs (spaces allowed).  Only after naming these new ROIs should the desired 
segmentation method (MANUAL, REGION GROWING, …) be selected from the 
Method section of the SEGMENTATION TOOL floating interface. Click NONE if you 
are not proceeding with the segmentation now, or QUIT to close the Analysis module 
(this will delete from memory the ROIs not stored on disk). 
 
Segmentation is performed slice-by-slice, building up a 3D region (ROI) by using one 
of the three different methods available: MANUAL, REGION GROWING, and 
THRESHOLD. Only in THRESHOLD and REGION GROWING is the User allowed to 
extend the segmentation of the current slice to the whole stack of image slices. 
Segmentation masks (up to nine ROIs) associated with the image are stored in a 
separate file for later retrieval, editing or quantification. 
 
Segmentation methods: 
 

MANUAL:  When Manual is selected the floating interface shown in Figure 33. 
will appear. 

 

                            
  Figure 33. Segmentation Tool interface with manual method selected 

 
This segmentation method allows a freehand closed contour to be drawn around the 
desired region with the mouse. Begin by clicking the DRAW button to activate the 
“draw’ function.  Then position the mouse cursor at the starting point of the contour.  If 
you click the mouse, move the cursor and left-click again, a straight line will 
automatically be drawn that connects the last endpoint with the current point. 
Alternatively, you may hold down the left mouse button and draw a continuous, 
freehand contour around the region as shown in Figure 34. In either of the modes, a 
right click on the mouse must be used to close the contour.  Clicking the CLEAR 
button will erase the draft contour. 
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     Figure 34. Freehand contour drawn on a slice using manual segmentation 
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Once the contour is closed, the Add to ROI button must be pressed to save the ROI 
and assign it the name that is currently active in the ROI window.  When this button is 
pressed, a color will fill in the ROI indicating a successful save and name assignment 
(Figure 35).  The same contour can also be included in another ROI by selecting it 
from the list and clicking again on Add to ROI. 
 

EXPLORE VISTA (2.26)  Visualization & Analysis   User: Admin
QuickTime™ and a

Graphics decompressor
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            Figure 35. Filled-in freehand contour assigned the name “region1” 
 
The same ROI may be added to other slices by clicking on Slice + or – to move up 
and down through the image stack. A dotted duplicate of the previous slice contour 
will then be shown on the new slice (Figure 36). If the INHERIT button is then 
pressed, this dotted version of the contour will be copied (no editing allowed) onto 
the new image.  Activating the auto Inherit check box will keep the contour active 
throughout the image stack. 
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            Figure 36. Dotted contour that can be copied using inherit button 

 

 
THRESHOLDING: The floating interface in Figure 37 will appear when this method is 
selected. 

 

                                   
    Figure 37. Segmentation Tool interface with thresholding method selected. 

 
 

With this segmentation method, an ROI can be created by selecting all slice pixels 
within a specific range of gray levels. Typing a value in the MIN or MAX text window 
or using the slider bar will set the range extremes. Clicking the GROW button will 
create a draft region for the current slice colored in pale blue (Figure 38), whereas 
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the GROW 3D button will extend the segmentation through the whole image stack. 
The User can modify the selected range of gray level interactively, till the desired 
region is obtained. As in the other segmentation modes, clicking the Add to ROI 
button will save the ROI and its name for the current slice.  
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Figure 38. Draft selection created using THRESHOLD method and GROW3D appears in 
pale blue (left) until the User presses Add to ROI button (right) 

 
 

REGION GROWING: The floating interface shown in Figure 39 will appear when 
this method is selected.  
 

                                 
Figure 39. Segmentation Tool interface with region growing method selected 

 

This segmentation mode is an advanced version of the THRESHOLD mode with an 
added pixel connectivity criterion. This mode groups pixels which are next to each 
other and that also share a similar gray level. You must set the range of gray levels 
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and also a seed point upon which the connectivity criteria is built. The segmentation 
begins by clicking the SET button in the SEEDS menu. This will set a seed point at 
the cursor position when the left mouse button is clicked, and a seed icon will appear. 
Then, clicking the GROW button or modifying the gray level range will create a draft 
region colored in pale blue. Multiple seeds can be set to add other portions of the 
image within the desired gray level range that are not connected (i.e. the left and right 
parts of bilateral structures). Seeds can be added or removed with the SET or 
CLEAR buttons on the SEEDS menu. The connectivity criteria can be intentionally 
interrupted in a specific area using the FRONTIERS tool, which allows you to draw 
breaking lines. Clicking the SET button will activate the left mouse button to draw 
frontier lines on the screen. Clicking the right mouse button ends the frontier line. As 
with the seeds, more than one frontier can be set. Frontiers can be set or removed at 
cursor position with the SET or CLEAR buttons on the SEEDS menu. 
 
Typing a value in the MIN or MAX text window or using the slider bar sets the range 
extremes. Clicking the GROW button will create a draft region for the current slice 
colored in blue. The User can modify the selected range of gray level interactively 
until the desired region is obtained. As in the other segmentation modes, clicking the 
Add button will create permanently save the ROI for the current slice with the current 
Region name. Clicking the GROW 3D button will extend the segmentation through 
the whole image stack (Figure 40). 
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Figure 40. Draft ROIs created using the Region growing method for two different seeds 
(pale blue - left) and after the User presses the Add to ROI button (right), adding it to 
any existing region. 
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ROI statistics: 
 

Information about every ROI can be obtained with the Tools->Statistics option. After 
selecting this option, a floating interface will appear (Figure 41) that displays 
measurements made on the pixels within the selected ROI, e.g. volume, mean gray 
level…).  If a dynamic image is being analyzed, a frame slider will allow the User to 
select the frame from which the statistics are calculated. If the selected ROI is 
changed or updated, the statistics window will be automatically refreshed. 
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         Figure 41. Statistics window shows information from the selected ROI. 
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Time-activity curves: 
 

Time-activity (or Time) curves can be generated for a dynamic image sequence by 
selecting the Tools->Time Curve option (Figure 42).  
 

            
 
Figure 42. Time-activity curve created by applying a pre-defined ROI to 
a dynamic image sequence with the Temporal Analysis tool.  

 
If more than one ROI is active when this tool is selected, all of the time-activity curves 
will be plotted on the same graph.  Scaling of these curves is determined by the 
minimum and maximum values contained in the time-activity curves so that these 
graphs will not necessarily have a zero ordinate value. 
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APPENDIX 
 
A. SITING 
 
The following items are the responsibility of the User. 
 
SITING 
MAGNETIC FIELDS--Scanner must be outside the 5 gauss line (sphere) of any 
nearby MRI scanner or NMR spectrometer and ideally outside the 2 gauss line.  Care 
must be taken to insure that the scanner is not under or above these kinds of devices 
as well as next to these devices.  This warning is not based on measured effects but 
on precautions typically taken with such potentially interfering devices. 
 
RADIATION--The VISTA-CT machine should be operated in a space in which the  
ambient ionizing radiation field from sources other than the imaging subject will never 
exceed twice the natural background radiation level during active imaging including 
those times when stored radioactive sources are present and when nearby radiation 
emitting devices are operating.   The User should establish that this condition exists 
at the installation site by monitoring the selected area with a G-M survey meter for an 
extended period prior to delivery and installation of the system.  "Ambient radiation 
level" is defined as the level measured when all radioactive sources are removed 
from the imaging area and all nearby artificial sources of ionizing radiation are "off". 
 
RADIATION SHIELDING--VISTA scanners are unshielded from the sides in order to 
reduce the weight and control the weight distribution of the gantry.  As a result, 
radioactive sources of any kind must not be located in such a way as to irradiate the 
scanner from either side, the top or the bottom.  The scanners are shielded only to 
reduce the intensity of radiation originating from a region in the front or rear of the 
gantry and to some extent from portions of the scanning subject that are outside the 
field of view.   Accordingly, the scanner must not be located next to, above or below a 
radiopharmacy, near a patient waiting area where patients might contain radioactive 
tracer or near radioactive animals that might be caged near the scanner.  No 
radioactive material other than that in the scanning subject should be near the 
scanner during imaging and no material should ever be placed or stored on or around 
the scanning gantry, e.g. full or empty dose syringes, waste cans for radioactive 
material, the Ge-68 annulus, etc.  These precautions apply to any kind of ionizing 
radiation field that might impinge on the scanner including those from nearby X-ray 
emitting devices, e.g. CT scanners, X-ray machines, etc., even if these devices are 
not in the same room. 
 
OTHER NEARBY PET OR SPECT SCANNERS-- If two or more VISTA scanners are 
operating in the same general area, these machines must be located such that 
radiation from an animal, dose syringe, radioactive tubing, etc. at one machine does 
not significantly irradiate the second machine, particularly from the sides, during 
actual imaging. Accordingly, two nearby VISTA scanners should be physically 
separated from one another to the maximum possible extent and oriented such that 
the fronts or backs of the machines are opposite one another, i.e at opposite corners 
of a room facing one another.  These guidelines are the minimum needed to allow the 
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scanners to operate. No shielding can compensate for large amounts of positron-
emitting material brought near the gantry of any scanner during imaging so it is the 
User's responsibility to insure that this never happens during imaging.  It is also 
possible that an animal in one machine could contain enough activity to interfere with 
imaging on the other even during normal imaging depending on the amount of 
activity, the distance between the scanners and the orientation of the scanner with 
respect to each other.  Should this occur the User would have to introduce additional 
shielding at an appropriate place to reduce the radiation field incident on the second 
machine. 
 
The User should be aware that radiation shielding provided in most single photon 
imaging systems is insufficient to protect these devices against high energy positron 
annihilation radiation. If a SPECT or other kind of single photon scanner is to be 
operated in the vicinity of a VISTA-CT machine, particular care should be taken to 
prevent irradiation of the single photon machine with even modestly intense radiation 
fields from positron emitting animals, syringes, etc. Thin layers of lead that are highly 
effective against gamma radiation from common single photon isotopes, e.g. 140 keV 
gamma rays from Tc-99m, are essentially transparent to 511 keV radiation so that the 
performance of nearby single photon devices can be more easily compromised.  
Keeping positron sources inside thick Pb containers, heavily sheilding pump-driven 
injection devices, timing studies to minimize cross-contamination, etc. are among the 
various strategies that can be used to reduce across machine effects. The User 
should expose any nearby single photon scanner to realistic amounts of positron-
emitting sources while monitoring the performance of the single photon scanner to 
determine the effectiveness of any of these strategies.   
 
Similarly, the User should expose the VISTA scanner to realistic levels of single 
photon tracers used in single photon imaging studies while monitoring the 
performance of the VISTA-CT machine.  Although the front and back shields on the 
VISTA scanner are sufficient to totally absorb direct radiation from a low energy 
single photon source, scatter from  very high activity single photon sources, e.g. 12-
20 mCi doses of Tc-99m, can reach the VISTA detector array through the unshielded 
sides or scatter off the VISTA-CT aperture into the detector array.  Again, the User 
should experiment with doses, locations and prevention strategies until any 
deleterious cross-machine effects are eliminated. 
 
SPECIAL CONDITIONS—VISTA-CT, like any other device dependent on electrical 
power, should be sited in such a way as to avoid the possibility of water damage from 
overhead plumbing or piping in the imaging area.  The User should inspect the ceiling 
area above the imaging room and place the scanner where it is not underneath points 
where leaks might likely occur.  
 
ENVIRONMENTAL CONDITIONS—VISTA-CT must be operated under the following 
conditions: humidity--< 50% relative, temperature--< 72 degrees F, power—20 
amp/120V AC, weight—floor capable of supporting 100 pounds/sq. ft, dimensions—
1.3 m (wide) x 1.3 m (deep) x 1.5 m (high), HVAC to remove heat dissipation of 1500 
watts.  
B. PRE-INSTALLATION 
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POWER SUPPLY STABILITY AND CONTINUITY—VISTA-CT requires a stable and 
continuously available supply of electrical power to insure reliable operation.  The 
User must purchase a “UPS” (uninterruptable power supply) that can supply electrical 
power to the VISTA-CT machine during short power failures and that can prevent line 
voltage fluctuations and power surges during normal operation.   This UPS should be 
able to support VISTA-CT for a minimum of 20 minutes  at 1500 Watts without house 
power.  Two UPSs can be used if a single UPS with this rating cannot be found, one 
to power the VISTA scanner itself and the second to power the workstation.  Any 
UPS must also have the capability of being monitored from a distance through a 
serial port and, if possible, an internet connection. 
 
INTERNET CONNECTIONS—The User is strongly advised to install two internet 
connections in the imaging room and to obtain two static IP addresses so that the 
scanner and workstation can be interrogated remotely over the internet for QC and 
diagnostic purposes.  Such connections can greately speed installation of new 
software and facilitate timely diagnosis/correction of any problems that might arise 
with the scanner.  
 
C. Ge-68 ANNULUS TRANSMISSION/CALIBRATION SOURCE 
 
The User must purchase an appropriate Ge-68 annulus (SR or DR versions) from 
Isotope Products and have this sealed source on hand at the time of delivery of the 
scanner.  It is the User's responsibility to pay for this phantom, to have the required 
licenses to order and take receipt of this radioactive object and to store and handle 
this phantom in a manner in accord with state and/or federal regulations.  The User is 
responsible for maintaining the currency of Ge-68 phantoms and agrees to purchase 
such phantoms at approximately one year intervals to keep the strength of this source 
high enough for timely calibration and transmission imaging. 
 
Ge-68 annulus handling and radiation field: 
Transmission imaging and calibration procedures require use a Ge-68 filled plastic 
annulus that fits closely into the aperture of the VISTA scanners.  The dimensions of 
this annulus have been chosen such that the annular volume containing the positron 
emitter Ge-68 just spans the axial field-of-view of the scanner when the annulus is 
properly positioned in the aperture.  The annulus is slid or pushed into the aperture 
from the rear of the scanner with an insertion tool specific for that scanner type 
(single ring or dual ring).  When fully inserted, the tool positions the active annular 
volume of Ge-68 exactly in the center of the axial field of view. 
 
These annuli are radioactive and contain about 500-600 microCuries of Ge-68 at the 
time of delivery from Isotope Products to a customer.  The actual radioactivity content 
and the calibration date are written on the outside of each annulus. With this half-life 
these sources must typically be replaced every 12 months or so if enough activity is 
to be present to efficiently perform both normalization and transmission imaging of 
small animals (the other use of this source). 
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Ge-68 is a pure positron emitter with a half-life of approximately 275 days and is 
uniformly distributed in an epoxy resin within the active volume of the annulus.  Care 
should be taken to store this source in a thick-walled Pb container surrounding the 
source on all sides including top and bottom. In addition, care must be taken not to 
physically damage the annulus by rough treatment.  Fracturing an annulus could 
potentially contaminate a laboratory for an extended period of time or force an 
expensive decontamination of the accident site.  More importantly, cracking or 
opening the annulus in any way could also potentially contaminate workers in 
violation of radiation safety regulations and likely put in jeopardy the radioactivity 
license held by the customer.  These sealed sources should be safely stored until 
use, transported quickly and securely to the scanner, inserted into the rear quickly but 
carefully with the insertion tool and then removed with equal care when the source is 
no longer needed and returned to its shielded storage box.   
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Figure 43.  Exposure rates (mR/hr) from a 500 microCurie Ge-68 annulus centered in 
the axial field-of-view of a VISTA dual ring (DR) tomograph.  Exposure rates for the 
VISTA SR scanner may differ somewhat from these values because of differences in 
geometry and internal shielding. 
 
When the source is in the scanner, an easily seen sign should be posted (taped) to 
the scanner gantry that says “Radioactive Ge-68 Source in Aperture-Maintain 
Distance!”.  It is not easy to see that an annulus is actually inside the aperture and 
individuals who come by, or stand near the scanner, may not know it is present.  The 
sign is required to keep radiation exposure to these individual to a minimum and to 
make all parties aware of the fact that the source is in use and not in its storage 
container. The exposure levels at various locations around a VISTA DR scanner with 
an annulus in place are shown in Figure 43 above. 
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D. STARTING/STOPPING THE DATA ACQUISITION COMPUTER 
 
Normally, a Main Power Switch restart of the VISTA scanner will automatically bring 
the workstation and the data acquisition computer to full operation.  In the rare event 
that the data acquisition computer (DAQ) fails to start, you can start this computer 
manually. Conversely, if you wish to turn VISTA-CT completely off, you can perform 
an orderly shutdown of the data acquisition computer that will leave the system in a 
secure state.  
 
STARTING--If the scanner appears to be ON but unresponsive to commands to 
initate data acqusitions, go around to the rear of the machine and determine if the 
data acquisiton computer POWER light (or any of the LEDs) is ON (see Figure 44).  
If these lights are off, you can initiate the IPMI software procedure described below to 
start the data acquisition computer from the Workstation.  
 
How to use the IPMI software: 
 

1. Open the IPMI View application in the user interface. 
 

 
Figure 44. 

2. Press double click on the configured connection as is shown in the Figure 45. 
 

                                                     Figure 45. 
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Log in using user ADMIN and password ADMIN (set by default). If the connection 
is successful a message of CONNECTED will appear as shown in Figure 46. 
 

                                                     Figure 46. 
 
3. There will be some tabs below where you can find all the functionality of this 

application. In the IPMI Device can be found some buttons to power on, power  
     off and reset the server. 

                                           Figure 47. 
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STOPPING—Occasionally, you may wish to turn VISTA-CT off, e.g. move it to a new 
location, change power outlets, etc.  If so, the IPMI procedure described above 
should FIRST BE USED TO SHUT DOWN THE DATA ACQUISITION COMPUTER 
prior to un-powering the scanner. Although protections exist against unplanned 
shutdowns that might damage operating hard drives, use of this IPMI shutdown 
procedure will guarantee the integrity of the DAQ for the next start-up. While the 
scanner can be shut down simply by pushing the Main ON/OFF button to OFF, and 
can be re-started by pushing this same button to ON, this procedure runs the small 
risk of damaging hard drives that are in operation when the switch is moved to OFF. 
The IPMI procedure avoids this risk and is recommended whenever you purposefully 
shut the system down. 
 
E. USER ACCESS TO FORE SINOGRAMS 
 
VISTA-CT can produce fully reconstructed and corrected images that should be 
sufficient for most experimental studies.  However, some users may wish to 
manipulate VISTA data prior to reconstruction with available VISTA software and 
instead use their own reconstruction or pre-reconstruction processing methods, e.g. 
different methods of scatter correction, etc.   
 
Because of the way data are acquired with VISTA, the best (and only) place for the 
user to access these data is at the end of the Fourier RE-binning process where the 
acquired 3D data are transformed into 2D sinograms, one for each slice.  Because 
most users will never need access to these sinograms, and hence do not need the 
extra burden of recording and moving these sinograms around on a routine basis, 
access to FORE sinograms is provided only if the user so wishes.  
 
To gain access, the user creates a text file in the directory shown: 
 
                                              C:\FORE\keep_sino.text 
 
The user then simply enters a “Y” (for “yes”) in this file as the first and only element in 
the file and saves the file.  As the form of this statement implies, this command tells 
VISTA-CT to “keep” the FORE “sinograms” from then on rather than deleting them 
after reconstruction. 
 
After the user take this action, the FORE sinograms for every reconstruction will be 
saved and will be accessible to the user in a form that can be viewed with VISTA-CT 
software like any other image or can be retrieved for data processing purposes. The 
sinogram filenames will have the form: 
  
                         … username_25June05_acq003_sino     .img & .hdr   
 
This example output is from the third (003) acquisition by “username” on 25 June 
2005 and is a sinogram file, that can be viewed and manipulated like any other .img 
& .hdr images. 
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The user can turn off this process simply by opening the sino.text file, deleting the 
character “Y” and saving this file.  FORE sinograms will be not be saved from then 
on.  
 
F. SOFTWARE OPTIONS 
 
ECG/Respiratory Gated Formatting—This capability, not supplied as part of the 
standard VISTA-CT software package, is available as an option (see Figure 21) and 
is accessed with the TIMING button on the Main VISTA-CT Interface. This item 
allows you to create a single, average cardiac or respiratory cycle from many such 
cycles.  This procedure is also known as “signal averaging” and requires a 
physiological marker that occurs at the same moment in time during a heartbeat or a 
breath and that can be used to align each single cycle to a common starting point 
before averaging.  The logical steps required to produce such an average cycle are 
shown in Figure 48. 
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gating devices, cardiac or respiratory, are not included in this VISTA-CT option and 
you are responsible for providing the input trigger signals in TTL format.  Pin 
assignments for the VISTA-CT input connector are provided at the time the gating 
option is purchased. 
 
VISTA scanners have a multi-pin input connector on the side of the enclosure that will 
accept TTL signals from up to four independent gating devices at the same time.  
Note, however, that no provision is made in the sorting software to allow logical ANDs 
or Ors of these signals and only one gating channel can be processed at a time.  That 
is, while both a respiratory signal and an ECG R-wave signal can be acquired by 
VISTA simultaneously, and this same data set sorted into gated respiratory and into 
gated ECG images, these data cannot be sorted into a data set where conditions 
have been placed on both signals simultaneously, e.g. use only data from cardiac 
cycles that occur midway through a respiratory cycle. 
 
A gated study begins by connecting the trigger output of the gating device to the 
VISTA-CT physiological input connector.  Once the animal is correctly positioned in 
the  
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                  Figure 49.  ECG/Respiratory Gated Formatting menu. 
 
field-of-view and the tracer administered, a LIST mode acquisition is started through 
the New Acquisition menu.  Upon completion of this collection, the ECG/Respiratory 
option shown in Figure 22 is selected from the TIMING menu. 
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This step transforms the acquired gated LIST mode data set into a consecutive 
sequence of raw data blocks that appear to be raw data from a dynamic study of 
known frame lengths (and, hence, able to be reconstructed into images). 
 
You first identify the LIST mode data set by filename (Figure 49) and VISTA-CT 
appends the .acq suffix to the output filename indicating that the output data set is still 
in raw form.  When this window opens, only the upper portion of the window is visible 
and the portion of the window inside the dotted box cannot be seen.  You then enter 
the channel number in which the gate signal of interest occurs (1, 2, 3, or 4), specify 
the duration of each frame in the gated sequence(e.g. 10 msec if a cardiac study in 
mice) and specify the allowable range of cycle length fluctuations permitted in the 
data used to create the average cycle. Hit “START” and the sorting process begins. 
 
When the formatting routine has finished, the items inside the dotted box in Figure 49 
are displayed.  These data should be recorded for future reference.  Sorting will give 
rise to a number of data blocks equal to the number of frames per cycle and will 
display the conditions found while creating these data blocks, i.e. mean cycle length, 
measured cycle length variation (standard deviation of cycle length/mean cycle 
length), as well as the values entered for frame duration and percent allowed 
variation in cycle length.  
 
These data are now in a form where they can be reconstructed into images using the 
provided reconstruction methods. The User identifies the filename output by the 
ECG/Respiratory sorting routine to the selected reconstruction menu and initiates the 
reconstruction. 
 
After reconstruction, these images can be manipulated with the Visualization and 
Analysis tools in much the same way that a dynamic studies can be displayed. If, for 
example, the image sequence represents cardiac motion by virtue of labelling the 
blood pool with an appropriate tracer, these data can be displayed in “cine-loop” 
movie format.  This simple visual technique, used routinely in human cardiac studies, 
is an extremely effective way of detecting subtle differences in regional myocardial 
wall movement.  Similarly, the time variation of ventricular volume (and ventricular 
pump function) can be quantified by plotting time-activity curves over the ventricular 
chambers with the tools provided in the VISTA-CT Analysis software package. 
 
Bear in mind when specifiying frame duration in the Formatting menu that the number 
of frames requested for the average cycle (mean cycle length/frame duration) will be 
equal to the number of data sets that must be reconstructed with FBP, OSEM or 
other algorithms.  In the example cited above, a 100 msec long cycle was divided into 
10 time frames.  Each of these 10 frames must be reconstructed individually and if a 
FBP reconstruction takes 90 seconds, ten will take 900 seconds or about 15 minutes.  
Reconstruction times will be greater still with 2D OSEM so some thought should be 
given to trading temporal resolution against reconstruction time when entering frame 
duration for gated studies. 
 
3D OSEM IMAGE RECONSTRUCTION—Another option available with VISTA-CT 
scanners is image reconstruction with a 3D OSEM resolution recovery algorithm.  
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This option requires an external computer cluster as well as the OSEM codes tailored 
to the geometry of the VISTA scanners (SR and DR versions are different). 
Installation of the cluster and algorithm are performed by service personnel and the 
details of this process are provided at the time of installation.  Performance 
characteristics of this algorithm are available on request.  Menus from the 3D OSEM 
interface are included on the following pages primarily to illustrate the interactions 
required to initiate reconstruction on the cluster from the VISTA-CT workstation. 
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